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Lab 1
Newton’s Laws: Motion in One Dimension
1.1

Background

In this lab you will study the motion of bodies moving in one dimension. To minimize
unwanted forces on the test object, you will use an air track (see Fig. 1.1). The glider ﬂoats
on a cushion of air above the track, eliminating most of the friction between the glider and
the track. The glider can move freely with no horizontal force, or under the inﬂuence of
a constant horizontal force when attached via a tape to a weight suspended oﬀ one end of
the air track (see Fig. 1.2). By measuring the time, t, at which the glider passes several
positions, x, you can test Newton’s laws and measure g.

Figure 1.1: An air track with two photogates.
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Figure 1.2: Glider of mass m on the horizontal air track, connected by a tape to mass M
that falls vertically under the inﬂuence of gravity.
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Newton’s First Law

Newton’s ﬁrst law states that an object will move at constant velocity if no forces are imposed
on it. Thus, deﬁning the x axis to be along the direction of the velocity, its motion obeys:
x = x0 + vt,

(1.1)

where x is the position of the object at time t, x0 is its position at time t0, and v is its
velocity. You can test this equation by giving the glider a push (so that it has some nonzero
velocity) and seeing whether x increases linearly in time.

1.1.2

Newton’s Second Law

Newton’s second law states that the acceleration a of an object of mass m is proportional to
the net force F applied to it,

Fi = ma.
(1.2)
i

If the net force is constant, then the acceleration a is constant and the motion of the object
obeys:
at2
,
(1.3)
x = x0 + v 0 t +
2
with v0 the initial velocity.
To test this, you need to impose a constant force on the glider. You can do this by
attaching a hanging mass m to the glider (which itself has mass M) via a pulley, as in
Fig. 1.2. Let T be the tension in the tape connecting the masses, and g be the acceleration
due to gravity. The only horizontal force on the glider is the tension from the tape, so
Newton’s second law gives
T = Ma.
(1.4)
The hanging mass m feels both gravity (downwards) and tension T (upwards), so the second
law for its vertical motion is
mg − T = ma,
(1.5)
noting that the downward vertical acceleration a of the hanging mass is the same as the
horizontal acceleration of the glider. Substituting eq. (1.4) for T into eq. (1.5) gives
mg − Ma = ma,

(1.6)

or, upon rearranging terms,
g=a

M +m
.
m

(1.7)

By measuring the acceleration a and the masses M and m, you can ﬁnd gravitational acceleration g.
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Speciﬁc Instructions
Setup of the Air Track

Start air ﬂowing into the track by plugging in the air pump and/or turning on the switch
on the power strip.
The air track will probably already be set up, but you should check the following things:
• The four photogates (enclosed in U-shaped plastic tubing) should be set up so that
each one is blocked (and unblocked) twice every time the glider passes by. The system
will record the time when each gate is blocked, and not the times when they become
unblocked. To check the operation and positioning of the photogates, watch the red
lights on the photogate adapter box, which turn on when a gate is blocked.
• The distance between adjacent photogates should be longer than the length of the
glider (so the glider never blocks more than one photogate at a time).
• In the acceleration part of this lab, you will work with a glider, a hanging mass, and
a tape, connected as shown in Fig. 1.2. The tape slides along the curved bit of the
air track with minimal friction. Then, the glider will be accelerated by the hanging
mass. Brieﬂy set this up now, and make sure the tape is long enough that the glider
can start behind photogate 1, and that the glider will get through photogate 4 before
the hanging mass hits the ﬂoor.

1.2.2

Timing Software

The photogate timing is measured by a program called Princeton Timer A. Double click on
its icon (in the Physics 101 folder of your lab computer) to open the program.
Once the program is open, you can click on Collect to start data collection, and on Stop to
end a run. The system records the times of each successive blocking of a photogate, starting
with t = 0 at the ﬁrst event. That’s all there is to your data collection. Try the system a few
times, blocking the optical beams with your hand repeatedly to watch data being collected.
Note: the data collection system takes a second or so to organize itself after the Collect
button is pushed. If you get strange (generally negative) times in the ﬁrst few data entries,
it is probably because a photogate was interrupted before the system was actually ready to
take data. You can avoid this problem by pausing for a second after pushing the Collect
button, before starting the action.

1.2.3

Events

Because of the way your measurements will be made, it will be useful to think of yourself as
measuring the times and positions of eight “events” which occur as the glider moves from
one end of the air track to the other:
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1st photogate is blocked by the ﬁrst “ﬂag” on the glider .
1st photogate is blocked by the second “ﬂag” on the glider .
2nd photogate is blocked by the ﬁrst “ﬂag” on the glider .
2nd photogate is blocked by the second “ﬂag” on the glider .
3rd photogate is blocked by the ﬁrst “ﬂag” on the glider .
3rd photogate is blocked by the second “ﬂag” on the glider .
4th photogate is blocked by the ﬁrst “ﬂag” on the glider .
4th photogate is blocked by the second “ﬂag” on the glider .

You will measure the positions x and times t of each of these events, and ﬁt these data
to eqs. (1.1) and (1.3).

1.2.4

Measuring x Positions

You need to measure the position x of the front edge of the glider at each of the events
described above. You can do this as follows:
• Turn the air oﬀ (this makes the measurements a bit easier).
• Note in which direction the glider will be moving, and move the glider to the point
where its ﬁrst “ﬂag” is just starting to block photogate 1. By watching the lights on
the photogate box to see when the photogate is blocked, you should be able to do this
very accurately. Check that the photogate heights are set so that they are blocked by
each of the two ﬂags, and not blocked when the glider is at in-between positions.
• Once the glider is at this point, measure the position of the front edge of the glider
using the scale attached to one side of the air track. Note, you could equally well use
the back edge of the glider – just be consistent during these measurements. In fact,
the absolute position of the scale on the air track in both eqs. (1.1) and (1.3) aﬀects
only the constant term x0 , which is relatively unimportant; it does not aﬀect the value
of the constant velocity in your ﬁrst measurement, or the value of the acceleration g
in your second measurement.
• Make a measurement of the position of the front edge of the glider when its second
“ﬂag” is just starting to block photogate 1. Then, repeat this procedure for the other
three photogates. Record all your measurements in your lab book.

1.2.5

Motion with Constant Velocity

As your glider moves through the four photogates, the system will record the times of the
eight “events” discussed above. From your notebook, you know where the glider was at
the time of each event. So you can make a plot of position versus time. To do this, use
the program “Excel with WPtools”, whose icon is in your Physics 101 folder. (Excel is a
standard spreadsheet and graphing program. WPtools (Workshop Physics Tools) is an addon capability which simpliﬁes graphing and curve ﬁtting. See Appendix A for additional
details.)
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First, let’s test Newton’s ﬁrst law. If a tape is connected to the glider, disconnect it.
Give the glider a push, and let it pass through all four photogates. Start collecting data
before it gets to the ﬁrst gate, and stop after it leaves the fourth. If it bounces back and
retriggers some of the gates, just use the ﬁrst eight times recorded and ignore the later ones.
Without closing down the timer program, double click on Excel with WPtools to open it.
Answer No to a question about something already being open, and then click on File and
New and OK to bring up a blank spreadsheet.
Transfer your eight time values from the timer program into a column in Excel. You can
transcribe the measured values of time manually, or you can use the standard Copy and Paste
method.
Click on the ﬁrst value and hold the mouse button down while “swiping” the cursor down
to the last value. Then click Edit/Copy in the timer program, and go back to Excel. Click
on one Excel cell to highlight it, and use Edit/Paste to put the data in a column below the
highlighted cell.
Enter your data on the eight x positions in the next Excel column, with each value
adjacent to the corresponding value of t. Add a title to the box above the data in each
column. (Time or t to one column, Position or x to the other.)
To make a graph of position versus time, you have to tell Excel what to plot in the
vertical and horizontal directions. Swipe your cursor vertically across the title and data cells
corresponding to the horizontal variable (time). Then, while holding down on the Control
key, swipe the cursor across the title and data cells corresponding to the vertical variable
(position).
With the horizontal and vertical data selected, click on WPtools / Scatter Plot to make
your graph. Do the points lie close to a straight line? The slope of the line should be the
velocity of the glider. Estimate the value of the slope from the printout of the graph, and
write it down in the proper S.I. unit. Does the number seem reasonable?

Figure 1.3: Sample plot of distance versus time for zero net force.
Use the computer to make a graph with a polynomial ﬁt to the data. In terms of the
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general equation (1.3) for accelerated motion in one dimension, we expect position x to be
a quadratic function of time t,
(1.8)
x = a0 + a1 t + a2 t2 .
The value of the coeﬃcient a2 is expected to be zero for motion with constant velocity.
Highlight the two data columns as before, and click on WPtools / Polynomial Fit. Then
choose Order 2 for the polynomial, and click OK. You get a graph equivalent to the previous
one, but with lots of information added about the computer’s best ﬁt to your data.
You may want to resize the graph box, or to move some of the ﬁt data boxes around
or resize them, to get a good view of the new plot. Your instructor can also show you how
to reset the scales on the graph. For now, let’s focus on the meaning of the computer’s
information concerning its ﬁt to your data.
The numbers a0 , a1 and a2 are computed values for the coeﬃcients of the equation.
The Standard Error (SE) for each coeﬃcient is the computer’s estimate of how accurately
these coeﬃcients are known, based on how closely your data falls to the ﬁtted line. R2 is
a measure of the goodness of the ﬁt, which need not concern us.1 The Greek letter sigma
(σ) is, however, of interest. It indicates how far a typical data point deviates from the ﬁtted
line.
Does the ﬁtted value of a1 agree with the velocity you calculated manually from the slope
of your ﬁrst graph to within 1-2 times the reported Standard Error on a1 . If not, recheck
your procedures.
If the horizontal force on the glider were zero as desired, the ﬁtted value of the coeﬃcient
a2 should be zero to within 1-2 times its Standard Error. If this is not the case, check that
the air track is level, and that the air ﬂow is suﬃcient.

1.2.6

Motion with Constant Acceleration: Measuring g

Attach a tape to the glider and suspend it over the curved bracket so that a hanger can
also be attached, as indicated in Fig. 1.2. Add weights to the hanger so that its mass m is
between 15 and 25 g. Measure the masses of the glider and the hanging mass using a balance
or digital scale.
Release the glider and record times using Princeton Timer A as described above. Transfer
these times to Excel and enter the x measurements (if you didn’t save them earlier). The
displacement x should have a quadratic dependence on t (eq. (1.3)), so use the Polynomial
Fit option with Order = 3 to ﬁt the data to an equation of the cubic form
x = a0 + a1 t + a2 t2 + a3 t3 ,

(1.9)

which should result in a value of a3 consistent with zero if your data are good. Comparing
eqs. (1.3) and (1.9) we see that the acceleration of the glider is a = 2a2 . Then, calculate the
acceleration g due to gravity from eq. (1.7) as
g = 2a2
1

m+M
.
m

(1.10)

If, however, you are curious as to the technical signiﬁcance of the quantities R2 and σ, see Appendix D.
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Figure 1.4: Sample plot of distance versus time for accelerated glider.
The corresponding uncertainty σg in your measurement of g can be estimated as
σg = 2 SE(a2)

m+M
.
m

(1.11)

Include a printout of the plot of x vs. t and the results of the ﬁt in your lab notebook.
If the ﬁt coeﬃcient a3 is not zero to within 1-2 times SE(a3 ), your experimental technique
needs to be improved.
Is your measurement for g within 1-2 times the estimated uncertainty σg of the expected
value?
How does the uncertainty SE(a2 ) on the ﬁt coeﬃcient a2 obtained with the hanging mass
compare with that obtained previously when the glider slid freely?
Run the experiment two more times, using diﬀerent hanging masses, and calculate the
value of g twice more. Are the values systematically high or low? If so, can you think of
anything that might cause this experiment to go wrong?
From your three measurements of g, you can make another estimate the uncertainty σg
according to
Max(g) − Min(g)
.
(1.12)
σg =
2
Compare this with your estimate based on eq. (1.11).
The estimate (1.11) of the uncertainty in your measurement of g does not include the eﬀect
of the uncertainty in your measurements of the masses m and M. In fact, the uncertainty
σm on the hanging mass m leads to an additional uncertainty on g of approximately
σg = g

σm
.
m

(1.13)

Is this eﬀect larger or smaller than the uncertainty (1.11) associated with the curve ﬁtting?

Lab 2
Motion in Two Dimensions
This lab extends your exploration of Newton’s laws of motion to the case of two dimensions,
as described in secs. 2.2 and 2.5. To accomplish this, you will use a video camera and supporting computer software to capture, edit and analyze images of two-dimensional motion.
Sections 2.1, 2.3 and 2.4 introduce you to this infrastructure.

2.1

A New Tool

The ﬁrst goal of this lab is to acquaint you with a new tool. You will use a TV camera
to make videos of moving objects, and a computer to digitize the locations of objects in
your videos and analyze the motion. It is important that every member of your group learn
how to use the computer and analysis software. Be sure that you all take turns operating
the system and that, when you are the operator, your partners understand what you are
doing.
When your computer is ﬁrst turned on, the
screen should show an icon for a folder named
Physics 101 (similar to the folder for Physics
103 shown in the ﬁgure). Open this folder, by
placing the cursor on it and clicking with the
right mouse button and choosing Open, or by
rapidly clicking twice using the left mouse button. You will then see a screen with icons for
the programs that we will use in this lab.
These include:

• VideoPoint Capture: this program allows you to capture a series of images, called
“frames”, from the signal produced by a video camera.
• VideoPoint: the program in which you will do your analysis. It allows you to determine
the positions of objects in each of the video frames that you captured, and provides
ways to generate and analyze graphs of your data.
• Excel with WPtools: an extension of the common Excel spreadsheet program, which allows detailed calculations to be carried out on your data. The WP (Workshop Physics)
extensions, make it easy to use Excel’s sophisticated graphing functions.
9
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• WordPad: a utility word processor, generally used to write and print out simple text
documents, or to print out an image of any computer screens that you need to discuss
in your write-ups.
• Student Data: a folder with space for you to put your ﬁles.

2.1.1

Capturing a Single Still Image

Your ﬁrst task is to capture a still picture to give to your lab instructor to help him or her
remember your names and faces. To get an image from the video camera on your computer
screen and make a copy, follow the instructions below:
1. Open VideoPoint Capture, by double-clicking on its icon with the left mouse button.
2. A VideoPoint Capture Preview Screen appears, with a picture of whatever your camera
is viewing at the moment. Conﬁrm that your Preview screen is showing live video by
waving your hands in front of the camera. If the picture is too dark or too light, rotate
the aperture ring on the camera lens to change the amount of light level reaching the
camera’s sensor. (The lens admits light through a circular opening, or aperture, whose
diameter is controlled by rotating the ring. The larger the diameter, the more the light
and the brighter the picture.)
3. Position yourselves (re-aiming the camera if necessary) so that your faces pretty well
ﬁll the picture on the screen. Then reach over, hold down the ALT key, and hit the
Print Screen button near the right end of the top row of keys on your keyboard. This
makes a temporary copy of whatever was on the VideoPoint Capture screen when you
hit the button.
4. Now, open WordPad by double-clicking on its icon. Then choose Edit→Paste to insert
the image that was copied using the Print Screen command. (Please do NOT change
any of the computer or display settings in an attempt to make the image larger. Such
changes may interfere with your analysis program.)
5. Click on the Printer icon in the WordPad menu to make a copy of your picture. Write
your names on a printout of your picture and give it to your instructor. You may want
to make extra copies for your lab books, but dont let this become your goal for the
afternoon.

2.1.2

Stop and Think - What is a Digital Image?

Before trying to capture a video in the computer, let’s be sure that we understand what the
moving image on a television screen actually consists of. It is a series of individual stationary,
or still, pictures, appearing at a rate of 30 pictures, or frames, a second. Standard movie
ﬁlms consist of strips of such still pictures, recorded photographically at a slightly lower
frame rate. Our videos will generally be taken at 10 frames per second.
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Digital computers, and hence our electronic imaging systems, work only in quantized
units. Your camera divides the area that it sees into over 76,000 discrete elements, arranged
into a grid 320 cells wide by 240 cells high. You will see later that VideoPoint measures x
and y positions with twice this resolution, dividing the x-direction into 640 integer steps and
the y-direction into 480 steps. In either case, a 1-step by 1-step cell is called a pixel, for
“picture element.”
To determine the coordinates of an object in an image frame using VideoPoint, we will
use the mouse to position a cursor over the object, and the system will count the pixel rows
and columns to get to the location of the cursor, starting at the lower left of the image on
the screen. Then, if we know how many pixels correspond to a meter long object, we can
calculate real distances from the pixel counts. This is called “scaling the image”. We will
return to this shortly.
With real distances known from scaling the images, a nd with the time interval between
two chosen frames also known (a multiple of 1/10 sec, say), we can easily calculate such
things as velocities and accelerations of moving objects in our videos.

2.2

Physics Background

In this lab you will analyze the trajectory of a bouncing ball. The ball will be accelerated by
gravity in the y direction, but not in the x direction. Its motion should obey the equations
x = x0 + v0xt,

(2.1)
2

y = y0 + v0y t +
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Figure 2.1: Setup of the experiment.
The experimental setup is sketched in Fig. 2.1. A ball rolls down a ﬁxed rail (the
“launcher”). After it leaves the launcher it falls freely, bouncing at least twice on the table
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top. The camera takes a series of pictures at ﬁxed time intervals during the motion. By
measuring the position of the ball in each picture, you can test eqs. (2.1) and (2.2).

2.3

Acquiring the Data

You are now ready to record a video. If necessary,
minimize or close the WordPad window to get the
VideoPoint Capture screen back into view.
First, aim the camera to view the bouncing ball,
and make a few trial runs, watching the Editing screen
to see that the camera catches the motion properly.
Include a meter stick in the ﬁeld of view, for scaling
purposes. You may want to mark two or more positions on the meter stick with tape, to give two clearly
visible reference marks. Remember, the meter stick
should be the same distance from the camera as the
bouncing ball will be. Otherwise, your scale factor
will be in error.
Clicking on the button at the lower left of the
screen gives you the option of recording frames at
many diﬀerent rates. For the moment, set the frame
rate at 10 frames per second.
The Preview screen has a Record button to be
clicked when you are ready to start recording. To
stop the recording, hit the Escape (Esc) key at the
upper left corner of your keyboard. (You can also
click on one of the Stop buttons that appear, but this
doesn’t always work.) Try not to record more than 5
to 10 seconds of video at a time. Otherwise, the size
of the video ﬁles becomes outrageous.
Go ahead and take a video of the bouncing ball.
After you have stopped recording, the Editing screen
takes a few seconds to organize itself. It comes to a stop displaying the ﬁrst frame of your
recording, with a new control bar appearing at the bottom.
First, click on the right arrow at the left end of the control bar. The system will “play
back” your video. Note the round progress button below the picture moving across the
bottom of the picture as the video goes from beginning to end.
You can manually play the video, backward or forward, by using your mouse to shove
the progress button back and forth. You can also advance through the video a single frame
at a time, forward or backward, by hitting one of the two buttons at the right of the control
bar.
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Editing your Video: In general, your original video will contain more frames than you
will want to use for analysis. Today, we want to analyze the ball’s motion between two
consecutive bounces oﬀ the table.
First, use the progress and single-step buttons to choose the ﬁrst frame following a bounce
of the ball. Then click the First button at the lower right. The software then eliminates all of
the earlier frames from the record, and the display jumps to the last frame that you recorded.
Use the progress and single-step buttons until you see the last frame before the next bounce.
Then click on the button at the lower right, which now reads Last. Any later frames are now
eliminated from your video.
Naming and storing your VideoPoint capture ﬁles: The video containing your chosen
frames must be named and stored for future reference. We have provided a folder identiﬁed
by your lab groups meeting time (e.g., “Monday Afternoon Section”). This folder is found in
a higher level folder titled Student Data, which in turn is located on the hard drive partition
labeled STUDENTS (D:).
Click on the Save button at the lower right of
the VideoPoint Capture Editing screen. A screen
appears with the title Save Movie File As. . ..
You will want to get the section folder for your
lab section to show in the screen’s top Save
in: box. If the folder for some other section is
shown there, use the yellow icon with the leftand-up arrow to go to the Student Data folder,
and then double click on the folder for your section. Consult your instructor if you have any
diﬃculty getting your section name in the Save
in: box – if you don’t get this right, you may not be able to ﬁnd your data later!
At the bottom of the screen the system has suggested a name such as 07 24 02.mov. The
ﬁrst two numbers (07) and (24) refer to the month of the year and the day of the month.
The last two digits are assigned by the computer, from 00 to 99, and starting again. You
may want to add more readable information. If your group’s last initials are P and Q, for
instance, you could use the mouse to insert “PQBounce” in front of the 07 24. Then the ﬁle
name would be “PQBounce07 24 02.mov,” which tells you a lot about the ﬁle, and will help
you remember what it was.
Click on the Save button. Your edited video ﬁle is now stored at the location and with the
name which you speciﬁed. It can be opened at any time for analysis, using the VideoPoint
software described earlier. For now, VideoPoint Capture provides a shortcut to allow us to
go immediately to analyzing your movie in VideoPoint.
Click on the Open in VideoPoint button that appears at the bottom of the VideoPoint Capture
image editing screen. This automatically opens the VideoPoint software package, and loads
your video ﬁle into it. In the Number of Points screen which ﬁrst appears, say OK to 1,
since there is only one object that we want to analyze (the bouncing ball). If you see an
information screen titled About VideoPoint, just click on the little x at the top right to make
it disappear.
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Data Analysis Using VideoPoint

Three windows appear when VideoPoint is ﬁrst opened. The Movie window shows the ﬁrst
frame of your edited video, with your ﬁle name appearing in its title bar. The Table window
shows three columns ready to receive your data. (The left hand column already has the time
entered for each of your video frames). The Coordinate Systems window will be used later to
manage your data operations. For the moment, simply note that it has a line for Point S1,
which is the name which VideoPoint has assigned to the single moving point which you said
you wanted to track.
The Movie Window
The Movie window in VideoPoint has the same video controls as before. To “activate” the
movie window, left-click on its title bar, where the name of your video should appear. The
title bar should now appear in blue, which indicates that we have selected that window for
our next steps. Try running the video, single-stepping through the frames, and moving back
and forth in time by moving the progress button from side to side.
Next, notice that when the cursor is moved into the image area of the movie window, it
changes shape and becomes a “cross hair” pointing device and the coordinates of the cross
hair’s position are read out at the lower left hand corner of the window. These coordinates are
expressed in a Cartesian system indicated by the two yellow lines that are superimposed on
the image. The numbers shown give the number of pixels you are to the right (x-direction),
and the number of pixels you are above (y-direction), the origin of this coordinate system.
The Table Window
VideoPoint will load your position data into the table shown in the Table window. By scrolling
vertically, you will see that the number of rows is equal to the number of frames in your
video, and that the time when each frame was recorded is already shown, in the ﬁrst column
of each row, starting with 0 seconds.
As you will soon see, positioning the cursor on top of a selected position in the Movie
window and clicking on the left mouse button will cause the x and y coordinates of any point
in each frame (the tip of a ﬁnger, say) to be automatically entered into the second and third
columns of the table, in the row corresponding to that particular frame.
The Coordinate Systems Window
Although we don’t need to use it in this experiment, you should know that the ﬁrst use
of the Coordinate System window is to describe an object in which you are interested. By
clicking on a Series Name, you can use your mouse to highlight and then change its name say from Point S1 to the more descriptive Bouncing Ball. You can also assign a mass to an
object, by clicking on and editing the value of mass assigned to it in the table. (The system
assigns an arbitrary value of 100 grams to every object, until you change it to a real value.
For the moment, just leave it at 100 grams.)
Later, you will see that this window is also useful when you want to Select an object
in order to change the way its points are plotted on a graph, etc. For the moment, just
note that clicking on the box to the left of a series name indicates that it has been selected,
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by highlighting the entire row. If you double-click in this box, a dialog box appears which
oﬀers an alternate means of changing series names, masses, etc., in addition to more complex
variables which we don’t need for the moment.

2.4.1

Scaling the Movie

You should have included a meter stick in your video. We’ll use it to convert our measurements from pixels to physical units.
First, choose any frame in which the meter stick is clearly visible. Move the cursor to
either end of the meter stick, and note the pixel coordinates at the two positions. Calculate
the distance between the two points, in pixels. Using the distance in pixels, calculate your
movie’s scale factor, in units of pixels per meter. Note the result in your lab book.
Now let VideoPoint do an automatic scaling of our movie. With the Movie screen selected,
move your cursor to the Movie menu item, and select the Scale Movie option. When the dialog
box appears, enter the length of the meter stick, and set the units of that length (cm, m,
inches, etc.) Then click on Continue. (Ignore the other items on the Scale Movie box.)
Follow the instructions to click ﬁrst on one end on the meter stick, and then on the other
end. Like magic, all of the x and y entries in your data table, and all of the x and y axes
of your graphs, are converted from pixel units to whatever physical unit (cm, m, inches,. . . )
you have chosen! Even the cursor position readout at the lower left of the Movie screen is
now in physical units.

Princeton University Ph101

16

Lab 2 Motion in Two Dimensions

Compare the value of VideoPoint’s scale factor (visible near the top of the Coordinate
System screen) with that which you calculated manually. Do they agree within “reasonable”
accuracy? Note any comments that you might have.

2.4.2

Picking Oﬀ Coordinates

After clicking on the Movie window to again make it the active window, review your video.
If you like, you can maximize the video image (i.e., make it full-screen) by clicking on the
center box at its top right corner. Repeating this action will make it small again, to let you
see the other screens.
Now we will run through an actual coordinate pickoﬀ:
1. Make sure that the Series Name labelle Point S1 is highlighted in the Coordinate Systems
window. Then click anywhere on the Movie window to make sure that it is the active
screen. Move your video back to its ﬁrst frame. Then move the cross-hair cursor
to center it on the ball. Press the left mouse button, being careful not to move the
cross hair oﬀ your chosen point as you press the button. This automatically enters the
coordinates of the cursor location into the corresponding line of the table window. The
video may automatically advance to the next frame. If it does, just continue clicking
on your chosen point to track its motion as the frames advance. If the frames don’t
automatically advance, just go to the Options item on the movie menu bar, and click
next to Auto Frame Advance.
2. Continue clicking on the ball for four or ﬁve frames. Your movie screen may or may
not be showing the positions you have chosen. In any case, stop and go to the Edit
movie menu item, and click next to the Leave/Hide Trails option. When the option is
clicked, you will see markers appear and disappear for each of the hand positions on
which you have clicked. Sometimes these are valuable, and sometimes they get in the
way. You can turn them on and oﬀ, using the option button. Continue picking oﬀ
coordinates, letting the frames advance automatically. That’s all there is to measuring
positions of moving objects in a video!
If you go back and step through the frames with the Leave Trails option on, you will
note that the label moves along the string of position markers. If the series has been
selected in the Coordinate Systems window, a second circle will also follow along the
trail of position markers.
The cursor always looks like an aiming circle when you are using it to pick oﬀ a points
location in any given frame. If the location of the point has already been determined
in any given frame, a circle appears around the location, and the cursor looks like an
arrow instead of an aiming circle.
3. If you make a mistake in positioning your mouse in a particular frame, you can simply
move the point. With the item selected in the Coordinate Systems window, and two
concentric circles showing around the previously chosen location, ﬁrst place the arrowshaped cursor at the center of the circles. Then, while holding down the left button
on the mouse, move the location circle to the new, corrected, position. Releasing the
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mouse button completes the change and enters the corrected coordinates into the data
table.

2.5

Graphing and Fitting Your Data Using Excel

While VideoPoint has some built-in graphing and curve-ﬁtting features, it is preferable to
transfer your table of values of x, y and t to an Excel spreadsheet.1 Then, you can apply the
methods you learned in Lab 1 to produce (and print out) plots of y vs. x, x vs. t, and y vs.
t. In addition, use WPTools to ﬁt the data of x vs. t to a Polynomial of Order 2, and to ﬁt
the data of y vs. t to a Polynomial of Order 3.
According to eqs. (2.1) and (2.2) the coeﬃcient a2 of the ﬁt to x vs. t and the coeﬃcient
a3 of the ﬁt to y vs. t should be zero to within 1-2 times their respective Standard Errors.
Coeﬃcient a1 of the ﬁt to x vs. t is the horizontal velocity of the bounding ball, and twice
the coeﬃcient a2 of the ﬁt to y vs. t should be the acceleration g due to gravity.
Report the x velocity and the y acceleration and their Standard Errors. Is the value of
g measured in this experiment within 1-2 times its Error of the expected value?
Repeat the entire process of data collection and analysis so that each member of your
lab group does each part of the experiment once.
Is the technique of Lab 2 better or worse than that of Lab 1 in measuring the value of g?

1

While in VideoPoint, click on the empty data cell to the left of the time column heading to select all of
your data columns, and then click on Edit/Copy data. Then open an Excel workbook, click on the upper left
cell, and click on Edit/Paste.

Lab 3
The Pendulum
3.1
3.1.1

Background
Pendulum Motion

θ

l

mass m

x

Figure 3.1: A simple pendulum, consisting of a mass m suspended from a string of length l.

The period T of a simple pendulum moving at small angles θ, as shown in Fig. 3.1, is
related to its length l and gravitational acceleration g by:


T = 2π

l
.
g

(3.1)

This is derived in your textbook and in section 3.4 of this writeup. In this lab you will
conﬁrm that the period T is proportional to l1/2 and that T is independent of mass m. Also,
you will use the pendulum to measure gravitational acceleration g with precision of about 1
part in 1000.

3.1.2

Logarithmic Plots

In this experiment, you will test eq. (3.1). In particular, you should show that T is proportional to l1/2 and not l1 or l2 or some other power of the length l. For this, you could
measure the pendulum period with several string lengths. But then what? You could try
ﬁtting curves of T versus l1/2 and T versus l1 and so on, to see which “looks best”. However,
there is a more quantitative approach to this problem: logarithmic plotting.
19
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Here’s the basic idea. You expect that T and l are related by an equation of the form:
T = c l α,

(3.2)

where c and α are ﬁxed constants, and you want to ﬁnd the value of the exponent α (which
you expect to be 0.5 for the pendulum). Take the logarithm of both sides of eq. (3.2) to get:
log T = log(c l α ).

(3.3)

The general logarithmic identities:
log ab = log a + log b,

log ab = b log a,

(3.4)

can be used to rewrite eq. (3.3) as:
log T = α log l + log c,

(3.5)

which is the equation for a straight line. For example, if you set y = log T , x = log l,
b = log c, and m = α, then you obtain the standard form,
log T = 
α log l + log c
  
  
y
= m
x + b.

  

(3.6)

Thus by ﬁtting a straight line to your measurements of log T versus log l, you can ﬁnd
value and uncertainty of the exponent α. To do this with Excel:
• Enter your l and T measurements into two columns of a spreadsheet.
• Calculate log l and log T . Use the LOG10 function in Excel (e.g., cell —sf B1 might
contain the formula =LOG10(A1)).
• Graph and analyze the log l and log T columns using WPtools/Linear Fit.
• The slope a1 and uncertainty SE(a1) reported from the ﬁt are the value of α and its
uncertainty σα.

3.2
3.2.1

Speciﬁc Instructions
Setup and Timing of the Pendulum

Set up a photogate at the bottom of your pendulum’s motion. Use the program Pendulum
Timer to measure the pendulum’s period. Start the ball swinging from a ﬁxed angle θ ≈ 2◦ .
(Use the protractor near the pivot point to set this angle accurately.) Then click on Collect.
The program Pendulum Timer actually measures the time between successive blockings
of the photogate by the swinging ball, and reports twice this value as the period. Hence, it
is important that the photogate be directly below the point of suspension of the pendulum
to get an accurate measure of the period.
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Pendulum Timer makes an entry in its data table, and also plots a point on the graph. It
continues to make measurements until you tell it to Stop. You should let it take at least a
few dozen data points, and perhaps many more on your repeated runs.
You can change the horizontal and vertical axis of the graph while the program is running.
Simply click on the lowest or highest values of either scale, and edit its value. You may want
to do this for the x direction simply to keep from running oﬀ the graph. Expanding the
vertical scale to include only a small range of values near your data points will allow you to
check for consistency and possible long term drift.

3.2.2

Dependence of the Period on the Initial Angle

An advanced analysis of the simple pendulum tells us that the period T is




1
l
θ0
θ0
9
T = 2π
1 + sin2 +
sin4 + ... ,
g
4
2
64
2

(3.7)

where θ0 is the maximum angle to the vertical during the motion. For “small enough” launch
angles θ0 the terms sin2 (θ0/2), and sin4(θ0 /2) are very small so that we obtain eq. (3.1). For
example, with θ0 = 10◦ the period would be increased by about 0.2% above the value
predicted by eq. (3.1), and for θ0 = 2◦ the increase is only 0.008%.
Can such small eﬀects be detected in your experiment?

3.2.3

Measurement of g

Measure the period of the pendulum using a fairly long length l and the steel ball. Estimate
the uncertainties of l and T . From equation 3.1, you can calculate g as:
g = 4π 2

l
.
T2

(3.8)

Using calculus (Appendix B.3), one can show that:


σg
g

2

=

σl
l

2

+ 2

σT
T

2

(3.9)

Using these formulae, estimate the measured value of g and the experimental uncertainty
σg .
Report your measured value of g to your AI. Measured values of g will be collected from
all groups of lab partners for statistical analysis of precision and uncertainties. Appendix
C reports the results of such an analysis based on data collected in Ph101 Lab 3 during a
previous year. You may wish to read Appendix B to appreciate better this error analysis
procedure.
A precise measurement of g, using a diﬀerent technique, was made by J. E. Faller in
Palmer Hall (now the Frist Student Center) room 130 for his 1962 Ph. D. Thesis. He found
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that:
g = 980.1604 ± 0.0007 cm/s2 .

(3.10)

How does your measured value compare with this? How does your uncertainty compare
with the one obtained by J. E. Faller? If you repeated the experiment 100 times, what would
be the uncertainty on your answer? In principle, could the uncertainty reach 10−6 m/s2 ?

3.2.4

Dependence of the Period on Length

Measure the pendulum period with 5 diﬀerent lengths l around 50, 75, 100, 125 and 150 cm.
In each case, set up the pendulum, and then ﬁnd the value of l, measuring from the pivot
point at the top of the pendulum to the center of the ball. For each length, run Pendulum
Timer for at least ten pendulum periods, record the average period T , and analyze your data
for g and σg as in the previous part.
Enter your measurements of l and T into Excel, and use logarithmic plotting (described
in section 3.1.2) to ﬁnd the exponent α in:
T ∝ l α.

(3.11)

Does your measurement of the exponent α agree with the expected value of 0.5 to within
the error reported by Excel?

3.2.5

Dependence of the Period on Mass

Prior to the insight of Galileo that all objects fall at the same rate if air resistance can be
neglected, one might have supposed that the period depended on the mass m of the hanging
weight. Test this by measuring the period of the pendulum with a steel ball, an aluminum
ball, and a wood ball, always using the same length of string. Are the periods you measure
the same within the measurement precision?1 Note that if you don’t use the same length
of string for the diﬀerent masses, you might confuse the dependence of the period on length
(sec. 3.2.3) with possible dependence of the period on mass.

3.3

The Conical Pendulum (not for credit)

A conical pendulum is one in which the mass swings around at constant speed in a (horizontal) circle, as shown in Fig. 3.2, rather than swinging back and forth in a vertical plane
as in Fig. 3.1.
Using what you have learned in class, derive a formula the period T of a conical pendulum
of length l at angle θ from the vertical. (Hint: ﬁrst ﬁnd a formula for the speed of the
1

Pendulum motion is a variant on falling motion, which doesn’t depend on the mass of the falling object
if air resistance can be neglected. As Galileo argued, if heavier objects fell faster, then two masses tied
together should fall faster than either object by itself. But, if the lighter mass of the two fell more slowly, it
would “pull back” the heavier object, and the tied pair would fall more slowly than heavier mass alone.
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θ

r

Figure 3.2: A sketch of a conical pendulum. The pendulum swings around in a horizontal
circle.

pendulum, then use that to ﬁnd the time it takes to go around the circle). Your result
should be the same as the simple pendulum formula (3.1).
We will use the same setup as before, though we will not use the photogates. This
will also be a low-precision experiment, and you need not undertake uncertainty analysis.
First, set up the pendulum as before, with a length of around 50 cm. Now unclamp the
pendulum and its short horizontal supporting rod from the experimental setup. The string
should remain clamped into the rod, so that the length l of the pendulum does not change.
Notice that if you move the rod in the proper manner you can get the pendulum moving
in a more-or-less circular motion. Test your formula for the pendulum period by measuring
the period of circular motion for at least three angles θ.
To measure the period, use the stopwatch provided. It is diﬃcult to measure θ directly,
but you can ﬁnd it by measuring the diameter of the circular motion (2r in ﬁgure 3.2) by
operating the pendulum near a meter stick. This isn’t very accurate, but you should be able
to at least qualitatively verify the period formula. In particular, your formula should predict
that either the period increases with θ or it decreases with θ. Does this prediction hold true?

3.4

Appendix: Derivation of the Pendulum Formula

A simple pendulum is sketched in Fig. 3.1, and a free-body diagram of its mass is given
in Fig. 3.3. Note that x is measured along the arc of motion of the mass; at the instant
pictured, the x axis is at angle θ above the horizontal. The only force in the x direction is
gravity:
Fx = −mg sin θ.

(3.12)
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y
x

T

W=mg

Figure 3.3: Free-body diagram of the pendulum mass.
For small angles, and θ in radians, we can approximate sin θ  θ. Further noting that
θ = x/l, eq. (3.12) becomes:
x
(3.13)
Fx = −mg .
l
Newton’s second law, combined with the deﬁnition of acceleration, says:
Fx = max = m

d2 x
.
dt2

(3.14)

Using eq. (3.13) for Fx and canceling m on both sides of the resulting equation gives:
g
d2 x
= − x.
2
dt
l

(3.15)

This diﬀerential equation has solutions like:
x(t) = x0 sin

g
t .
l

(3.16)

Note that this goes through one cycle when the argument to the sine function is 2π, that is,
when:

l
t = 2π
(3.17)
g
so this is the period of the pendulum.

Lab 4
Collisions in Two Dimensions
In this laboratory you will study two-dimensional collisions between two objects (pucks) on
a horizontal, low-friction surface (an air hockey table), as sketched in Fig. 4.1.1 Use the CCD
camera to take a series of images before, during, and after the collisions, and then analyze
the images to test conservation of momentum and energy and to evaluate the motion of the
center of mass of the objects.
Camera

Figure 4.1: A sketch of the experimental apparatus.

4.1

Background: Two-Body Collisions

A collision between two bodies is a brief interaction between them during which the forces
are very strong (but equal and opposite according to Newton’s third law).
This lab involves collisions only between pucks of equal mass, which substantially simpliﬁes the analysis.

4.1.1

Momentum Conservation

The total momentum of two masses m1 and m2 with velocities v1 and v2 is ptotal = m1v1 +
m2v2 . During a brief collision any external forces are small compared to the forces between
the two masses, and the latter forces sum to zero. Newton’s second law tell us that during the
1

Please don’t actually play air hockey with the lab equipment! The pucks break easily and are diﬃcult
to replace.
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collision the rate of change of total momentum is equal to the total force, which is negligible.
Hence, the total momentum is the same before and after the collision:
m1v0,1 + m2 v0,2 = m1vf,1 + m2 vf,2,

(4.1)

and we say that the total momentum is “conserved”.
Since momentum is a vector, each component is independently conserved. Write down the
equations for the momentum conservation in the x and y (horizontal) directions m1 = m2.
In this lab, the vertical velocities of the pucks are always zero, so momentum is “obviously”
conserved along the vertical direction.

4.1.2

Center of Mass Motion

A concept related to the total momentum of a system is its center of mass velocity, vcm,
deﬁned by
ptotal
m1 v1 + m2 v2
vcm =
=
,
(4.2)
mtotal
m1 + m2
for a two-body system.
Since total momentum is conserved in a collision, the center of mass velocity is unchanged
during a collision.
If in addition, the total external force on the system is zero, then the total momentum
and the center of mass velocity are constant at all times.
A constant center of mass velocity implies that some aspect of the system moves along a
straight line at constant speed. That special property is the center of mass position vector,
rcm , deﬁned by
m 1 r1 + m 2 r2
rcm =
,
(4.3)
m1 + m2
for a two-body system.
Write down the equations for horizontal coordinates xcm and ycm of the center of mass
for a system of two equal-mass pucks. Where is the center of mass located, between or
outside the pucks? What are the distances from the pucks to the center of mass in terms of
the distance between the pucks?

4.1.3

Elastic and Inelastic Collisions

Mechanical energy may or may not be conserved during a collision (in contrast to the total
momentum which is always conserved during collisions).
If mechanical energy is conserved, we say that the collision is “elastic” (meaning that if
the pucks compress slightly during the collision, they rebound to their original shape after
the collision).
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The mechanical energy of a two-body system is the sum to the kinetic energies of the
two masses. Hence, in an elastic collision,
1
1
1
1
2
2
2
2
+ m2 v0,2
= m1 vf,1
+ m2vf,2
.
m1v0,1
2
2
2
2

(4.4)

Write down the simpliﬁed expression for the case of equal masses.
If mechanical energy is not conserved during a collision, we call this an “inelastic” collision. In particular, if the two pucks stitck together after the collision (sec. 4.2.5), this
collision is called “totally inelastic”, and
vfinal = vcm =

m1v0,1 + m2 v0,2
.
m1 + m2

(4.5)

An extreme form of inelastic collisions occurs when the objects stick together after the
collision. In general, the objects then spin about their (moving) center of mass position.
Nonetheless, momentum is still conserved in such inelastic collisions.2

4.2

Speciﬁc Instructions

The camera and software are the same as you used in Lab 2 (the bouncing ball). If needed,
see that writeup for camera and image analysis instructions.

4.2.1

Setup

Turn on the two blowers to supply air to the table. Make a few trial runs at colliding two
simple pucks (no magnets, no Velcro bands). For your measurements, the collisions should
not be “head-on” (1-dimensional). But while practicing, try to arrange a head-on collision
between a moving puck and one at rest. What is the simple result of such a collision? Weigh
each of the pucks and record the results in your notebooks.
Now start playing with VideoPoint Capture to get a good video of a collision between
your two pucks when both have nonzero initial velocity. Include a meter stick near the edge
of the camera’s ﬁeld of view. The pucks must be visible for 4-6 frames before and after the
collision. It is better if none of the puck velocity vectors, nor vcm , is parallel to a coordinate
axis. (Use the Preview Screen to see if you need to try again. If so, use the <<Record button
at the left of the screen.) When you get a good video, name it and store it in a ﬁle. Then
open it in VideoPoint.
In the initial screen in VideoPoint, choose “2” as the number of objects whose positions
you want to track. Note that the Coordinate System screen has two lines, labeled Point S1
and Point S2. These labels identify your two pucks.
You may want to make the movie screen as large as possible before making your measurements. It can be maximized by clicking on the middle button at the top right of the screen.
2

There is another conservation law that applies to collisions, namely conservation of angular momentum.
This law can be helpful in understanding the details of inelastic collisions, but we do not pursue this here.
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When you are ready to digitize the puck’s positions, move the cursor to the center of the ﬁrst
puck in the ﬁrst video frame, and click on it. Note that the cursor’s label changes from Point
S1 to Point S2. Click on the center of the second puck in this frame. Note that the frame
advances automatically, and the label changes back to S1. Continue clicking alternately on
the two pucks, and advance through the frames to the end.
Some time during your clicking, stop and turn on the Edit/Leave Trails option. You will
have to do this two times (once when the cursor shows S1, and once when it shows S2). The
trails for one puck will be red, and the others will be green. If you have gotten mixed up in
your clicking, you can start over again by clicking on Edit/Clear All/OK.

vf2
vf1
v01
Figure 4.2a: Image of a
collision.

4.2.2

v02

Figure 4.2b: Calculating
initial and ﬁnal velocities.

Figure 4.2c: The center of
mass at a given time is
highlighted by a dot.

Center of Mass Motion

When you have ﬁnished digitizing your video, the movie window will show the trails of both
of the pucks, in all of the frames. If you haven’t already done so, maximize the size of the
movie screen. Then print out a copy of the video image. Figures 4.2a, b and c suggest how
you could use the image to carry an analaysis, using a ruler to ﬁnd the positions of the center
of mass of the system of two equal-mass pucks in each frame.
However, it is more accurate to transfer your data as to the (x, y) positions of the pucks
at the various times of the frames into an Excel worksheet. Calculate the corresponding
coordinates (xcm , ycm) of the center of mass using Excel to implement eq. (4.3) (See Appendix
A.3). Print plots of xcm vs. ycm , xcm vs. t and ycm vs. t.
If there are no external forces (and there shouldn’t be in this experiment), the center of
mass will travel in a straight line at constant velocity. Do the positions of your center of
mass follow a straight line, and does its speed appear constant?
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Is Momentum Conserved?

Test conservation of momentum by checking that the equations you derived relating the total
momentum before and after the collision hold true. To do this, you will need to ﬁnd the x
and y velocities of the pucks before and after the collision. You can do this using the data
you have already stored in an Excel worksheet, or go back to VideoPoint and se View/New
Graph to make four time plots of the components of the velocities of both pucks. Go back
to the movie window and use Movie/Scale Movie to change your data and graphs to physical
units.
From your graphs, determine what the velocity components of each of the pucks were,
just before and just after the collision. Then use the masses of the pucks to determine if
momentum was conserved. You need not do detailed uncertainty analyses, but do check that
the sum of the momenta before and after the collision agree, component by component, to
within a few percent. Otherwise, look for a gross error somewhere.
Is the speed (magnitude of the velocity) of each puck the same, before and after the
collision?

4.2.4

Is Energy Conserved?

Check energy conservation using the velocities you derived. Calculate the squares of the
speeds, multiply by half the masses, and see if the total kinetic energy of the system is the
same before and after the collision. If not, what fraction of the energy was lost? Into what
other forms of energy might the lost kinetic energy have been converted?

4.2.5

Velcro Pucks and Totally Inelastic Collisions

Put Velcro straps around a pair of (non-magnetic) pucks. Now when the pucks collide
they will stick together. Make a video of a collision for which the pucks rotate slowly after
colliding. (See Fig. 4.3b.)
Even though the individual pucks aren’t moving in straight lines after the collision, the
center of mass should move in a straight line. Print out the image and use a ruler to ﬁnd
the center of mass in each frame (as in sec. 4.2.2). Do the points line up? Is momentum
conserved, i.e., is vcm thet same before and after the collision? Is translational kinetic energy
2
2
+ v0,2
)/2 = mvf2 ?
conserved, i.e., does m(v0,1
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Figure 4.3b: Diagram of puck
motion. After the collision,
Figure 4.3a: Colliding Velcro
Figure 4.3c: Center of mass of
the pucks stick together (and
pucks.
the Velcro pucks.
slowly rotate in a clockwise
direction in this example).

4.2.6

Optional Study: Magnetic Pucks

Experience in this lab has been that a substantial fraction of energy is usually lost in collisions
in which the pucks actually hit each other. This energy loss can be reduced if the pucks
interact without contact. This can be done using magnetic pucks, which can repel each
other without actually touching. Note: the magnet pucks are fragile, and can be damaged if
dropped or harshly handled.
Practice launching the magnetic pucks so that they come close to each other, and their
paths are changed, but they do not touch. You may need to use relatively low puck velocities,
and to decrease the frame rate when taking your videos.
Once you’ve gotten a good video using the magnetic pucks, open it in VideoPoint and
redo the conservation of momentum and conservation of energy calculations above. Is kinetic
energy conserved better than before? Is momentum conserved?

Lab 5
Rotational Motion
5.1

Experimental Apparatus

In this experiment you study rotational motion and its connection with translational motion.
The experimental apparatus is sketched in Fig. 5.1. A large disk (radius r1 ) and a smaller
disk (radius r2 ) rotate together on an axle. A string is wound around the smaller disk,
and a mass m is attached. As the mass falls under gravity, the pulley undergoes angular
acceleration.

SIDE
VIEW

Photogate

photogate

r1
r2

axle

axis of rotation

m

m

Figure 5.1: A sketch of the experimental apparatus.

In this type of apparatus, sometimes called Atwood’s machine, the vertical acceleration a
of mass m is much less than g, so the behavior of accelerated motion is easier for the human
eye to discern.
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5.2
5.2.1

Lab 5 Rotational Motion

Moment of Inertia of the Pulley
Background

When a body of mass m rotates about an axis, its motion can be analyzed using quantities
analogous to those found useful for linear motion. Namely,
position x
velocity v
acceleration a
mass m
force f
F = ma

→
→
→
→
→
→

angle θ,
angular velocity ω,
angular acceleration α,
moment of inertia I,
torque τ,
τ = Iα.

The moment of inertia I of a uniform disk is
πρr4 h
1
,
I = Mr2 =
2
2

(5.1)

where M = πρr2h is the mass of the disk of mass nedisty ρ, radius r and thickness h
(see Cutnell and Johnson Table 9.1). According to eq. (B.13) of Appendix B, the relative
uncertainty σI /I in the moment of inertia I is given by
σI
I

5.2.2

2

=

σM
M

2

σr
+ 2
r



2

=

σρ
ρ

2

+

4σr
r

2

+

σh
h

2

.

(5.2)

Speciﬁc Instructions

The actual pulley (Fig. 5.1) consists of two disks of masses M1 and M2 with radii r1 and r2,
respectively. The total moment of inertial I of this pulley is
1
1
πρ 4
(r h1 + r24 h2 ).
I = I1 + I2 = M1 r12 + M2 r22 =
2
2
2 1

(5.3)

Dismount the (aluminum) pulley and measure its outer radius, r1 , and thickness h1 . Also
measure the radius, r2 , and thickness, h2 , of the smaller disk, and then calculate the moment
of inertial I using eq. (5.3), taking the density of aluminum to be
ρ = 2.70 ± 0.01 g/cm3.

(5.4)

Estimate the uncertainty σI using eq. (5.2).
Does the moment of inertia of the smaller disk make a signiﬁcant contribution to the
total moment of inertia I of the pulley?
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Measuring I from Rotational Dynamics
Background

An alternative method of measuring the moment of inertia I of the pulley uses its acceleration
by a falling mass. The mass is attached to a string, which is wrapped around the smaller
part of the pulley (radius r2), as shown in Fig. 5.1.
Analysis of the system is straightforward. First consider the pulley. The tension T of the
string exerts a torque1
τ = T r2
(5.5)
about the axle of the pulley. This torque leads to an angular acceleration α of the pulley,
related to torque by
τ = Iα.
(5.6)
Combining these gives
I=

T r2
.
α

(5.7)

Next consider the falling mass m. The forces on mass m are tension and gravity, so
Newton’s second law says:
mg − T = ma,
(5.8)
where g is the gravitational acceleration constant and a is the acceleration of the mass. Since
the string is wrapped around the pulley at radius r2 :
a = αr2 .

(5.9)

Combining these gives an expression for tension:
T = m(g − αr2 ).

(5.10)

Substituting this into eq. (5.7) yields:
I=

mgr2
− mr22 .
α

(5.11)

For an estimate of the uncertainty σI on the moment of inertia I, note that eq. (5.11)
can be rewritten using eq. (5.9) as
I = mr22

mgr2
mgr2
g
−1 ≈
=
,
a
a
α

(5.12)

where the approximation holds since a  g. Then, using eq. (B.13) we have
σI
I
1

2

≈

σm
m

2

+

σα
α

2

+

σ r2
r2

2

.

Clockwise torques and downward translational motion are taken to be positive.

(5.13)
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Speciﬁc Instructions

Use a falling mass of m ≈ 200 g to measure the moment of inertia of the pulley. Measure the
value of m with a scale. Wrap the string around the smaller disk in a single layer, avoiding the
groove. For precision results, measure the diameter of the string with the Vernier caliper,2
and increase your previous measurement of the radius r2 of the smaller disk by the radius of
the string to obtain the lever arm through which the torque acts.
Use a photogate and the program Princeton Timer A to measure the angular acceleration
α of the pulley. Two tabs are attached to the larger pulley; they will cause the photogate to
be blocked at intervals of π radians. Make sure that both tabs block the timer gate.
The system will record the times when the photogate is blocked. Thus, each time reported
by the computer is the time it takes the pulley to turn an integer multiple of π radians.
The string should be wound in a single layer on the small pulley. Start the Timer program
before releasing the mass (recall sec. 1.2.2), and stop the Timer before the mass hits the
ground. Leave the Timer on long enough to record at least 5 time intervals.
The angular motion of the pulley due to the constant angular acceleration α is described
by
1
(5.14)
θ = θ0 + ω0 t + αt2 .
2
You can ﬁnd both α and σα by ﬁtting a curve to a plot of θ versus t. Use Excel and WPTools
with a Polynomial of Order 3. The ﬁt coeﬃcient a3 should be 0 to within 1-2 times the
reported error SE(a3). Then, α = 2a2 and σα = 2 SE(a2).
Use your measurement of α and eq. (5.11) to calculate the moment of inertia I of the
pulley. Calculate the uncertainty σI using eq. (5.13).
Compare this value of I with the value (5.3) you calculated from the dimensions of the
pulley. Do they agree within the larger of the uncertainties σI obtained from eqs. (5.2) and
(5.13)?

5.4

The Block and Tackle

In this part of the lab, you analyze the block-and-tackle system sketched in Fig. 5.2. First
examine the system in equilibrium, then analyze the kinetic and potential energies of the
system in motion.
Before setting up the block-and-tackle system, wind the string used in the ﬁrst part of
this lab around the pulley and secure it with a piece of tape. Please don’t remove it.
Construct the system as shown in the ﬁgure. The “ﬁxed” pulley is the one used in the
ﬁrst part of this lab. The “moving” pulley should have about 100 g as a load. Measure the
mass m2 of the moving pulley (including its load) before assembling the system. Attach a
string to the axle of the ﬁxed pulley (or better, to a nearby piece of the supporting structure),
2

Lengths can be measured to 0.1 mm using the Vernier caliper. Consult with your AI if you are unfamiliar
with this technique.
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fixed
pulley

ω1
ω2
moving
pulley

v2

m2

v1
m1

Figure 5.2: A sketch of the black-and-tackle system
pass it around the moving pulley, back up over the ﬁxed pulley, and down to the hanging
mass. The string should be long enough that when the hanging mass (m1) is near the ﬁxed
pulley the moving pulley (m2 ) is close to the ﬂoor. The string should loop around the groove
in the hub of the ﬁxed pulley, and it should not slip when the pulley and the masses move.
Loop it around twice if necessary to avoid slippage. Also be careful that the string freely
winds and unwinds without tangling.

5.4.1

Static Equilibrium of the Block and Tackle

Adjust the mass of the hanging weight m1 until the system is in static equilibrium. Keep
adding weights until the hanging mass would fall if only 1–2 g more were added. Remove
the hanging mass and measure m1. What relation do you expect between m1 , m2 , and the
tension in the string? Do your measured values of m1 and m2 agree with this expectation?

5.4.2

Dynamics and Conservation of Energy of Block and Tackle

Background
Consider what happens if m1 is increased, so the system is no longer in equilibrium. Mass
m1 will fall downwards, causing the moving pulley to move upwards and both pulleys to
rotate. The motion can be analyzed in terms of forces and torques, but it turns out that an
energy analysis is simpler.
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The kinetic energy KE of the system at any instant is:
1
1
1
1
KE = m1v12 + m2 v22 + I1 ω12 + I2ω22 .
2
2
2
2

(5.15)

The moment of inertia of the moving pulley, I2, is suﬃciently small that the last term may
be ignored. The other terms can be simpliﬁed by noting that:
v1 = ω1 r2

and

1
v2 = ω1 r2 ,
2

(5.16)

where r2 is the radius of the ﬁxed pulley at the point the string is wrapped, including the
radius of the string as in sec. 5.3.2. (Why is there a factor of 1/2 in expression for v2?)
Inserting these expressions into eq. (5.15) and simplifying gives:
1
KE =
2



1
m1 + m2 r22 + I ω 2
4

(5.17)

Now consider the change in potential energy between two times. This is just the change
in mgh for both masses, but here we will measure θ instead h. If the ﬁxed pulley rotates by
an angle of Δθ, mass 1 falls by height h1 = r2 Δθ, while mass 2 rises by height h2 = r2Δθ/2
(do you see why?). The change in potential energy is then:
1
ΔPE = m1 gh1 − m2gh2 = m1 − m2 g r2 Δθ.
2

(5.18)

If friction in the system can be ignored, then the kinetic energy (5.17) at any moment
should be equal to the change in potential energy (5.18) since the beginning of the motion.
Speciﬁc Instructions
Add 150–200 g to the hanging mass and re-attach it to the system. Release the mass and
record the time intervals of successive half-turns of the ﬁxed pulley, using the same procedure
as in the ﬁrst part of the lab. Be sure that you start the timer after the mass has started
falling, and stop the timer before the mass hits the ﬂoor.
To calculate the initial and ﬁnal kinetic energies using eq. (5.17), you need to know the
initial and ﬁnal angular velocities of the pulley. The measurements reported are the times
it takes the pulley to turn by successive multiples of π radians. Thus the average angular
velocity in any interval is
π
Δθ
=
.
(5.19)
ω=
Δt
Δt
Use the time measurement for the ﬁrst time interval reported by Princeton Timer to calculate ω0 , the average angular velocity during this interval, which is equal to the angular
velocity at the midpoint of this time interval. Then use eq. (5.17), along with your measurements of m1, m2 , r, and I from the ﬁrst part of the lab to ﬁnd the kinetic energy of the
system at the middle of the ﬁrst time interval. Similarly, use Δt from the last time interval
to calculate ωf and the kinetic energy at the midpoint of this time interval.
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If the data set contains N numbers, then the pulley rotated a total of Δθ = (N − 1)π
radians between the midpoints of the ﬁrst and last time intervals. Use this in eq. (5.18) to
calculate the change ΔPE in potential energy between the midpoints of these time intervals.
Does your measurement of ΔPE agree with the diﬀerence between initial and ﬁnal kinetic
energy? You need not perform a detailed uncertainty analysis, but if the numbers don’t agree
within 5–10%, look for a gross error somewhere.

5.5

Angular Momentum Toys

Sometime during the lab period, go to the back of the room where several angular momentum
toys are set up. Take a ride on the rotating stool, pulling the dumbbells in and out to change
your moment of inertia. Also try twisting the spinning bicycle wheel while sitting on the
stool.
Try pouring water into the funnel attached to a copper tube gadget. What is the resulting
motion of the system? Is angular momentum conserved in this device?

Lab 6
Springs and Simple Harmonic Motion
6.1

Background

Springs provide a useful model for many physical systems that exhibit oscillatory behavior.
The key characteristic of springs is that, when stretched or compressed by an amount Δx
from their relaxed position, they exert a force proportional to Δx:
F = −kΔx,

(6.1)

where k is the spring constant. If a mass, m, is attached to one end of the spring, it will
oscillate with angular frequency:

k
.
(6.2)
ω=
m
The corresponding period is:
T = 2π

m
.
k

(6.3)

In the ﬁrst part of the experiment you will verify these equations. In later parts you will
analyze systems with more than one spring.

6.2

Speciﬁc Instructions

The setup for the ﬁrst part of the lab is shown in Fig. 6.1. A spring connects a glider of
mass M to one end of an air track. A hanging mass, m, is attached to the other end of the
glider via a string (actually a piece of magnetic tape).

k

M

m
Figure 6.1: Equipment setup for the ﬁrst part of the experiment.
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Equilibrium

Analyze the system in equilibrium and ﬁnd the equation which relates the mass, the spring
constant and the displacement.
Measure the equilibrium positions, x, of the glider with an empty hanger and also with
at least four diﬀerent weights. Measure the masses of the hanging weights on a balance or
digital scale for precision results.
Fit a line to a plot of m versus x. Use the equation you previously derived to extrapolate
k and its uncertainty, σk , from the ﬁt parameters. Use g = 9.8 m s−2 where needed.

6.2.2

Oscillations of a Single Spring

If you displace the glider and release it, it will oscillate back and forth on the air track. Set
up a photogate so that it is blocked twice per cycle (once for each direction of motion). Now
you can use Pendulum timer to measure the oscillation period. For each measurement you
make, ﬁnd the period for several cycles of the motion, and use the average period. Just use
the Stat (for Statistics) button located above the graph.
The period of oscillation of the glider should be:


mtotal
m+M
= 2π
,
T = 2π
k
k

(6.4)

independent of the amplitude of the oscillation (just as the period of a pendulum was independent of amplitude). Test this by recording the period of oscillation for glider displacements of
around 4, 6, and 8 cm. Use larger displacements if necessary to avoid the eﬀects of damping.
Use the same hanging mass m for each of these trials. Do you measure the same period
within the experimental uncertainty?
Next test the dependence of T on mass m + M. Measure the period of oscillation with
the hanger empty, then with 20 g of additional mass, and ﬁnally with 40 g of additional mass.
Compare these measured periods with periods calculated using eq. (6.4).
Another useful comparison can be made by rewriting eq. (6.4) as
k = 4π 2

m+M
.
T2

(6.5)

Use this to calculate three values of the spring constant k from your three measurements of
period T as a function of mass M. For a simple statistical analysis, take your best estimate of
k to be the average of the three values, and the uncertainty to be σk = |Max(k) − Min(k)|/2.
Compare these results with those you obtained in part 6.2.1.

6.2.3

Two Springs

Set up the glider with two identical springs as shown in Fig 6.2. What is the eﬀective spring
constant of the combination of springs? What is the expected period?
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M

m
Figure 6.2: A glider connected to the air track via two springs.

Measure the period of the system. Does it agree with what you expected? You need not
do a detailed uncertainty analysis, but the numbers should be in the same ball park. If not,
repeat sec. 6.2.1 to verify the spring constants of the springs that you used.

6.2.4

Three Springs, Two Masses

Set up two gliders and three identical springs as shown in Fig. 6.3. Displace one of the gliders
from its equilibrium position while holding the other ﬁxed. Then let them both go at the
same time. The resulting motion can be quite confusing!

M

M

Figure 6.3: Two gliders and three springs.
You need not analyze the motion of the gliders in its full complexity. Instead, you will
study two special cases of motion called ‘normal modes, in which all movement takes place
it a single frequency. It turns out that any one-dimensional system of springs that includes
N masses has N such modes. Thus the two-glider system has two normal modes.
The ﬁrst normal mode occurs when the gliders move but the distance between them does
not change. Displace both gliders by the same amount and in the same direction, and release
them. The middle spring should keep a constant length, and the gliders should oscillate with
the same period. Measure the period of oscillation of this mode (T1) using the photogate
aligned on one of the gliders.
The other normal mode occurs when the gliders move in opposite directions with equal
amplitudes. Displace one glider to the right and the other to the left by the same amount,
and release them. Again the gliders should oscillate with the same period. Measure this
period (T2). Does the center of mass of the gliders combination move?
Compare your measured periods with those deduced in sec. 6.2.5 below. You don’t need
to do a quantitative analysis of the uncertainty, but your measured periods should be close
to those calculated in the analysis.
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If you start the system by holding one glider ﬁxed at its equilibrium position and displacing the other glider, you will create a motion that is a combination of the two modes
studied above. With time, one or the other of the two modes may be more apparent, in an
alternating pattern. However, if you are not attuned to the presence of the two modes, the
motion may appear to be chaotic (a technical term meaning behavior that appears to be
complex but which nonetheless obeys simple laws of physics).

6.2.5

Analysis of Normal Modes for 3 Springs and 2 Masses

During the ﬁrst normal mode the force from the middle spring never changes since its length
never changes. Therefore, the changing force on, say, the left glider is only due to the change
in length of the leftmost spring. If k is the spring constant of each of the springs, then the
force on the left glider is:
FL = −kΔxL,

(6.6)

where ΔxL is the displacement of the left glider. Thus the period of oscillation in the
ﬁrst normal mode is:


T1 = 2π

M
.
k

(6.7)

During the second normal mode the left glider experiences changing forces from both the
left and middle springs. After a displacement ΔxL the leftmost spring exerts force −kΔxL
on the left glider. Meanwhile the middle spring exerts force −k(2ΔxL) on the left glider
since the middle spring is compressed (or stretched) twice as much as the leftmost spring is
stretched (or compressed). Note that the direction of the force on the leftmost glider is the
same for both springs, so the net force on the left glider is:
FL = −3kΔxL.

(6.8)

Thus the “eﬀective” spring constant is 3k and the period of this mode is:


T2 = 2π

M
.
3k

(6.9)

Lab 7
Fluids
7.1
7.1.1

Flow of a Viscous Fluid in a Circular Pipe
Background

It is a remarkable fact that ﬂuid immediately adjacent to an immobile surface, such as the
wall of a pipe, always has zero velocity. For ﬂuid some distance y from the surface to ﬂow
at velocity v, a force must be applied:
F =

ηAv
y

(7.1)

where A is the area of the surface (or, equivalently, the area of the layer of ﬂuid), and η is
the coeﬃcient of viscosity.
Fluid ﬂow through a circular pipe is slightly more complicated. The ﬂow rate, Q, (=
volume of ﬂuid passing any cross section of the pipe each second) through a circular pipe of
radius R and length L is given by Poiseuille’s law:
Q=

πR4 ΔP
8ηL

(7.2)

where ΔP is the diﬀerence in pressure at the ends of the pipe. The R4 dependence is
dramatic: a small reduction in R leads to a large reduction in the ﬂow rate in the pipe (a
blood vein, for example).
If v is the ﬂow velocity at the center of the pipe, then the ﬂow rate is Q = πR2v/4,
where the factor of 4 arises due to the variation of velocity with distance from the wall of
the pipe. From eq. (7.1), v = F R/ηA, where the force F is the pressure diﬀerence times the
cross-sectional area, F = πR2 ΔP , and the area A of the surface of a length L of the pipe is
A = 2πRL. Combining these facts, we arrive at Poiseuille’s law (7.2).

7.1.2

Speciﬁc Instructions

Use the apparatus shown in Fig. 7.1 to test Poiseuille’s law and to measure the viscosity of
a ﬂuid. The ﬂuid is a heavy machine oil, which ﬁlls the large vertical cylinder. Its weight
produces the pressure at the bottom of the cylinder and, therefore, at one end of the small
horizontal tube. The other end of the horizontal tube is at atmospheric pressure. Thus the
pressure diﬀerence across the length of the small tube is ΔP = ρgh, where h is the height
of the ﬂuid above the outlet of the (possibly curved) tube.
43
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h

Figure 7.1: Apparatus for the study of Poiseuille’s law. The vertical cylinder is partly ﬁlled
with oil. It is open to the atmosphere at the top. The height h is to be measured between
the liquid level and the outlet of the tube.

Measure the mass of an empty graduated cylinder
Measure the ﬂow rate in each of the three available tubes (radii 0.370, 0.307 and 0.242 cm),
using a stopwatch and a graduated cylinder. Let the oil drop directly to the bottom of the
cylinder so the height of the oil surface gives an accurate measure of the volume of the oil.
Measure the mass of the cylinder plus oil, and read the volume of the oil in the cylinder
to determine the density ρ of the oil.
Hints: Keep the small tube horizontal to minimize the eﬀect of gravity on the ﬂow.
Measure the height of the ﬂuid in the vertical cylinder before and after the oil ﬂows out, and
use the average value. From which point should the height be measured?

7.1.3

Analysis

First use your data to test the assertion that Q is proportional to R4 . Although it isn’t
strictly true, you may assume that each tube has the same length L. Then you can write
eq. (7.2) as:
Q = Constant × Rα

(7.3)

You want to check that the exponent α is 4. Do this by analyzing your measurements of Q
using logarithmic plotting, as discussed in sec. 3.1.2.
Next, determine the value of the viscosity η of the oil. For this part of the analysis,
assume that the exponent α = 4. Rework the Poiseuille’s equation to extract the value of
the coeﬃcient of viscosity, and use your three measurements of Q to calculate three values
of η. Are the values close to each other? Formal uncertainty analysis isn’t required, but look
for a procedural error if the measurements are grossly diﬀerent.
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Terminal Velocity
Background

An object falling through a viscous ﬂuid feels three forces.
Gravity pulls the object downward:
Fgrav = mg = ρV g,

(7.4)

where ρ and V are the density and volume of the object, respectively, and g is gravitational
acceleration.
The buoyant force pushes the object upward:
Fbuoy = ρf V g,

(7.5)

where ρf is the density of the ﬂuid. Finally, there is a drag force which acts to oppose the
motion of the object.
The drag force on a spherical object of radius R moving with velocity v is given by Stokes’
law:
Fdrag = 6πηRv,

(7.6)

where R is the radius of the sphere.
Stokes’ law (7.6) is a variant on the basic rule (7.1). The area of the sphere is A = 4πR2 ,
its volume is V = 4πr3 /3, and the y = 2R/3 is the distance from the surface of the sphere
at which the surrounding ﬂuid is hardly perturbed by the motion of the sphere.
When these three forces balance, no net force acts on the sphere, so it falls with constant
velocity, called terminal velocity. Combine eqs. (7.4)-(7.6) for the three forces acting on the
sphere to derive an expression for the terminal velocity.

7.2.2

Speciﬁc Instructions

Test the equation you just derived by measuring the terminal velocity of small lead spheres
falling through the oil you analyzed in the ﬁrst part of the experiment. The density of lead
is ρ = 11.4 g cm−3 .
Measure the diameter of one of the spheres, taking an average of several measurements
if it isn’t really spherical. Measure the velocity of the sphere falling through the oil using
a stopwatch. Repeat the experiment for at least three diﬀerent spheres. Are the measured
values close to the values predicted by your equation?
Solve for the viscosity η and compare with your result from sec. 7.1.
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Buoyant Force
Background

The density of gas in a helium balloon is less than the density of the surrounding air (ρHe =
0.165P kg m−3 for pressure P in atmospheres, ρair = 1.29 kg m−3 at 1 atm pressure), so the
balloon feels a net upward force. The buoyant force (7.5) can be balanced by hanging a mass
below the balloon, as shown in Fig. 7.2.

m1

Figure 7.2: Apparatus for the study of buoyant force.

The total weight is:
Wtotal = (m1 + mstring + mballoon + mHe) g

(7.7)

where m1 is the mass hanging below the balloon, mstring is the mass of the string, mballoon is
the mass of the (empty) balloon, and mHe is the mass of the helium within the balloon.
The masses of the balloon, string, and hanging weight can be measured on a precision
scale, and mHe = ρHe V where V is the volume of the balloon.

7.3.2

Speciﬁc Instructions

Measure the mass of the empty balloon. Fill it with helium, and after stopping the ﬂow of
helium, measure the pressure within the balloon before tieing oﬀ the end of the balloon. You
may need the following conversion factors: 1 atm = 15 psi = 1.013 × 105 Pa. Note that the
gas regulator measures gauge pressure Pg = P − Patm rather than the absolute pressure P .
Next measure the volume of the balloon. One way of doing this is to put it on a table,
hold a meter stick vertically next to it, and use a wooden board to help measure its size on
the meter stick (see Fig. 7.3). If d1 is the size of the balloon in its longest dimension and d2
is the size from side to side, its volume is approximately:


4
d1
V = π
3
2



d2
2

2

.

(7.8)
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d1
d2

Figure 7.3: Measuring the dimensions of a balloon.

Cut a piece of string 1-2 feet long, measure its mass and tie it to the bottom of the
balloon. Finally, tie a 5 g hanger to the string and keep adding weights to the hanger until
the balloon is in equilibrium. To ﬁne-tune the hanging weight, you may want to use small
paper clips (about 0.3 g each) or pieces of tape. After you have achieved equilibrium, detach
the hanger and its weights, and measure their total mass on a scale.
Now you have all data you need to test the buoyancy formula. Calculate the buoyant
force and the weight. Are they close to each other?

Lab 8
Speed of Sound and Speciﬁc Heats
8.1

Safety

Tanks of various gases will be available in the lab. Choose just one of these for your measurement of the speed of sound and, of course, use the same gas for measurement of the
density. The tanks contain gas at high pressure:
Do NOT try to move the tanks; if it is absolutely needed, ask the assistance of an
instructor.
Every tank has three valves: the main valve on the throat of the bottle, which allows gas
to enter a large reduction valve in the regulator, which bleeds the gas slowly out of a small
needle valve into the rubber tubing.
You need to use only the needle valve. The shutoﬀ valve and the regulator valve have
already been adjusted: do NOT tamper with them.
The pressure has been set high enough to give a ﬂow that will ﬁll your ﬂask in a reasonable
time.
If someone should increase the pressure it could cause a ﬂask to blow up! Do NOT touch
the regulator valve.
As you open the needle valve check for a gentle breeze of gas ﬂowing out of the rubber
tube when held near your lips (the “lip test”). Keep the needle valve closed except when
you need some gas ﬂow.

8.2

Velocity of Sound

In this lab you will measure the velocity of sound in a gas, and you will weigh the gas in
order to ﬁnd its density. These measurements will lead to a determination of CP /CV , the
ratio of speciﬁc heats at constant pressure and constant volume, and thus allow you to infer
the molecular structure of the gas. Measurements of macroscopic lengths, masses, and forces
provide insights on molecules of size ≈ 10−10 meters and mass ≈ 10−23 grams!
The speed v of longitudinal sound waves in gases is given by:


v=

γP
.
ρ

(8.1)

where ρ is the gas density in kg/m3 , P is the gas pressure in Pascals,and γ is the ratio of
the speciﬁc heat capacity at constant pressure CP to the speciﬁc heat capacity at constant
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volume CV :
γ=

CP
.
CV

(8.2)

The kinetic theory of gases predicts that γ = 53 for an ideal monoatomic gas and γ = 75
for an ideal diatomic gas. At standard temperature and pressure, γAr = 1.66, γCO2 = 1.29
and γN2 = 1.40.
Using the ideal gas law,
P V = nRT,

(8.3)

where the gas constant is R = 8.31 J/mole-◦ K, we can express the gas density as
ρ=

Mn
MP
m
=
=
,
V
V
RT

(8.4)

where M is the molar mass. What density does the ideal gas law predict for gases Ar, CO2
and N2 at standard temperature and pressure? What is the velocity of sound for these gases
according to eq. (8.1)?
If the sound wave has a pure frequency f and wavelength λ, then the velocity of sound
is related by
v = fλ.
(8.5)

8.2.1

Resonance

The apparatus for measuring the speed of sound is a vertical cylinder of gas (see Fig. 8.1).
The length of the column of gas is adjusted by changing the height of a metal reservoir of
oil. The gas volume is interconnected to the top of the oil reservoir so that the gas volume
does not change when the reservoir is raised or lowered.
A loudspeaker is attached to the top of the cylinder, and it generates sound from an
electrical audio oscillator. The loudspeaker also responds to sound vibrations (like a microphone) and thus the sound waves set up in the cylinder of gas aﬀect it also. This action is
detected by a meter. When the cylinder is in “resonance” you will get a large reading on
the meter (and you may be able the hear that the output of the loudspeaker is louder).
A resonant condition occurs when a pattern of longitudinal standing waves (sound waves)
is established in the gas column. This will happen only for a certain set of the lengths of
the gas column when the loudspeaker is driven at a pure frequency f. At the resonance, the
vertical vibration of the gas molecules is maximal (an antinode) at the tube end where the
loudspeaker is located. Of course, the vibration of the gas molecules is zero (a node) at the
liquid surface in the tube.
Deduce an expression which relates the height h of the gas column to the wavelength λ
of the sound at the resonances. Note that the resonating wave within the column has a node
at the surface of the oil and an antinode at upper, open end of the column. What is the
spacing Δh between neighboring resonances? Use eq. (8.5) to relate the speed v of sound to
the spacing Δh and the frequency f at the resonances.
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Figure 8.1: Apparatus for measuring the speed of sound.

8.2.2

Speciﬁc Instructions

As a preliminary step, turn on the oscillator at a convenient frequency ≈ 800 Hz. Lower
the oil reservoir top down about 60 cm while watching the meter and listening to the sound.
You should be able to ﬁnd several positions of the oil level at which resonance occurs.
The meter reading should be near the maximum of its scale at resonance – if it goes oﬀ
scale reduce the output level of the oscillator. You might ﬁnd that a diﬀerent frequency
(10-20%) will give a stronger indication of resonance. Explore a bit.
You are now ready to ﬁll the cylinder with gas from one of the tanks. Note that the
gas can be fed into the apparatus in a way to ﬂush out the gas previously there. Raise
the oil as high as possible during ﬂushing to facilitate this. Be sure to open and close the
valves in the right order so that the pressure in the tube is not raised above atmospheric
pressure. Lower the oil level from the top and note the approximate location of the ﬁrst
three resonances. Then raise the oil slowly through each resonance. Upward motion makes
is easier to determine the level of oil as you will discover on trying it both ways. Find the
position of resonance with the maximum possible accuracy.
Use the relation you previously derived to the speed of sound from the spacing Δh
between resonances and the frequency f of the audio oscillator.
Tip: a good way ﬁnd a resonance position is for one person to slowly raise the oil level
while another records the meter readings. The maximum can be found by graphing the
meter reading versus position.
Also explore the resonances keeping the height h of the oil constant while varying the
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frequency f fo the oscillator. What is the lowest resonant frequency for the height that you
have chosen?

8.3

Density of the Gas

Find the gas density ρ weighing a known volume of the gas at atmospheric pressure. Two
ﬂasks of equal volume are provided, one coated with plastic and the other clear.
Determine the useful volume of the coated ﬂask by ﬁlling the clear ﬂask with water to
the level of the rubber stopper in the coated ﬂask. Measure the volume of water.
Evacuate the coated ﬂask with the vacuum pump. You can tell when this is achieved
when a sharp clacking sound of the pump replaces the initial slurping sound.
Weigh the evacuated ﬂask. Be careful not to drop it. The plastic coating is to minimize
hazard of breakage.
Then ﬁll the coated ﬂask with gas at one atmosphere pressure, using the procedure
described below, and reweigh.
• To ﬁll the ﬂask, open the needle valve, repeat the lip test (sec. 8.1), and when a gentle
ﬂow is found attach the hose to your ﬂask and open the stopcock. The ﬂask is full to
over one atmosphere pressure when the hissing noise at the needle valve stops. Shut
the stopcock. Shut the needle valve and remove the tubing. Open the stopcock slightly
and gas will hiss out allowing the pressure to drop to atmospheric. If you leave the
stopcock open too long, ordinary air will mix with the gas in the ﬂask, thereby reducing
its purity.
• Weigh the ﬁlled ﬂask. After a minute, open the stopcock again brieﬂy and reclose.
Reweigh. Repeat after another minute. Reweigh. If the weight has not changed again
you are ﬁnished. If it has decreased, repeat again. Why does the weight change at all?
• You must measure the change in weight (a few grams) between the evacuated and ﬁlled
ﬂask, which can be done by moving the rider on the balance. Be sure that the weights
in the balance pan are not changed while you ﬁll the ﬂask with gas.

8.4

What Gas Did You Use?

The tanks are labeled so that they can be distinguished, but the labels indicating what gases
they contain are hidden. Sometime into the lab your AI will provide you with a list of gases
in the tanks. Can you determine which gas you used only on the basis of your measurement
of the gas density, or only on the basis of your measurement of the velocity of sound?
Use eq. (8.1) and your measurements of ρ and v to determine γ = CP /CV for your gas.
Was your measurement accurate enough to distinguish between monatomic, diatomic, and
polyatomic gases?

Appendix A
Data Analysis with Excel
Computers are used for data analysis in any modern physics laboratory, and the Physics
101 lab is no exception. We have built our data analysis system around the program Excel,
which is widely used on and oﬀ campus. We’ve added some Workshop Physics (WP) tools to
make graphing data easier, and to let you do regression calculations with uncertainties, but
otherwise we are using the standard, oﬀ-the-shelf software.1
If you are already familiar with Excel, great! If not, we’ll give brief instructions here.
Like any software, it can be confusing at ﬁrst, so don’t hesitate to ask your instructors and
your fellow students for help. Play around with the program a bit to get comfortable with
it.

A.1

Starting things up

• If the computer isn’t already on, turn it on and wait for it to boot up.
• If the Physics 101 window isn’t already open, double click on the Physics 101 icon to
open it
• Double click on Excel with WPtools (look for the X logo) to get the program running.

A.2

Entering Data: a Simple Example1

When Excel is started up, you need to open a spreadsheet to work in. If you are asked if
you want to reopen WPtools, click No. Then go to File→New and click on OK to open a new
Workbook. (If you wanted to open a pre-existing spreadsheet, you would use the File→Open
menu command; if you want to save the new spreadsheet, use the File→Save menu command.
Since we’ll be working with fairly small datasets, neither of these is really necessary for your
lab work.)
Suppose you wish to record some (x, y) data pairs in two columns of a spreadsheet. Go
to Excel, and start entering the data in the upper left most cell (called A1). To do this, move
the cursor to this cell and click on it with the left mouse button. Enter the ﬁrst x data value
1

Some online documentation for WPtools is at
http://physics.dickinson.edu/˜wp web/wp resources/Documentation.html
1
Note: Menu commands are described as follows: File→Open means move the cursor to the word File on
the line near the top of the screen, press and hold the left mouse button, drag the cursor down to the word
Open, and release the button.
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here, pressing Return when you are done. The cell below it (called A2) will automatically be
selected next; enter the second x data value here. Work down the ﬁrst data column in this
way. If you need to go back and correct any of the numbers, simply move the cursor with
the mouse, click on the relevant cell, and re-enter the number.
Once you’ve entered the ﬁrst column of numbers, move the cursor to the top cell of the
second column (cell B1) and click the left button to select it. Enter the ﬁrst y data value.
Press Return/Enter, and enter subsequent y data in the rest of the cells.

A.3

Calculations in Excel

Now that your two columns of data are in the computer, select them. Do this by moving the
cursor to the top left cell, pressing and holding the left mouse button, dragging the cursor to
the lowest ﬁlled cell in the second column, and then releasing the mouse button. The block
of numbers you entered will now be “selected”, indicated by a blue-grey color.
Go to the WPtools pull-down menu and select Linear Fit. Immediately Excel will display
a plot of your data, along with the values and uncertainties of the best-ﬁt line. Print out a
copy of the results if desired.2
Sometimes you will want to transform your raw data in some way before plotting it. For
example, you may have entered two columns of data as above, but you want to convert the
y values from inches to meters. This is where a spreadsheet program becomes really handy.
Select a blank cell somewhere on the sheet (cell C1 would be a good place). Instead of
entering a number, enter the formula ‘=0.0254*B1, and press Return. Excel will display the
expected numerical value in cell C1, and it will also remember the formula. This is useful
for two reasons, ﬁrst, if you change the value in B1, the number in C1 will be automatically
updated. Second, you can copy the formula in C1 to other cells, transforming the rest of
column B using the same formula. To do this, ﬁrst select cell C1. The cell becomes outlined,
and note that there is a little square in the lower right corner of the outline. Move the cursor
to this square, push and hold the left mouse button, drag the cursor down several cells, and
release the mouse button. Voila! Excel will use the same formula to multiply all the cells in
column B by 0.0254.
Excel can do much more complicated arithmetic. For example, you could use the formula
=sqrt(A1) * B1 to take the square root of the values of cells in column A, multiply them by
the values in column B, and put the result in some other column.
You might also want to take diﬀerences between the successive items in your data list. If
you type into cell C2 the formula =B2-B1, and then use the little square to ﬁll this formula
into the cells B3, B4, etc., then you will obtain the diﬀerences in column C.
If you do a transformation like this, and then you want to do a plot or a curve ﬁt, the
columns of data you want to plot may not be adjacent to each other. No problem. Say you
want to plot cells A1-A10 on the horizontal axis and cells C1-C10 on the vertical axis. First
2

You must ﬁrst “grab” the plot by left-clicking on an open area inside it. If the plot legends are obscuring
the graph, drag them aside with the mouse. Your can add labels to your plot using the Edit labels option on
the WPtools menu bar.
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select A1-A10. (Go to cell A1, hold down the left button, drag the cursor to A10, then release
the mouse button). Then hold down the Ctrl key and select C1-C10. Now both cell groups
A1-A10 and C1-C10 will be selected, but not B1-B10. Run the WPTools→LinearFit routine,
and you will get the plot you want.

A.4

Accumulating Values via Excel Tricks

There will be times in the Physics 101 lab when you want to accumulate sums of a series of
values. For example, you might have measured a series of time intervals,
Δt1 = interval between event 1 and event 2,
Δt2 = interval between event 2 and event 3,
Δt3 = interval between event 3 and event 4,
etc.
You may wish to convert these into a continuous time scale. In other words, you may want
to declare that t = 0 at the time of event 1, and then ﬁnd
time of event 2 = Δt1,
time of event 3 = Δt1 + Δt2,
time of event 4 = Δt1 + Δt2 + Δt3,
etc.
This is easy to do. Say that Δt1, Δt2, etc., are in cells A1, A2, etc., and you want to put
the accumulated times in column B. First put a 0 in cell B1 (since t = 0 for the ﬁrst event).
Then go to cell B2 and enter the formula =SUM($A$1:A1). The SUM function simply adds
up the cells in the range speciﬁed.
The usefulness of the $ notation becomes apparent when you want to calculate the rest
of the times. Select B2, move the cursor to the square in the lower righthand corner of the
cell border, press and hold the left mouse button, drag the cursor down several cells, and
release the button. The cells in column B are now ﬁlled with SUM functions, but in a special
way: The $A$1 in the SUM function call remains the same in all the cells (because of the
$), but the second part of the function call changes from A1 to A2 to A3, ... In other words,
cell B3 now reads =SUM($A$1:A2), cell B4 reads =SUM($A$1:A3), and so on. These are
exactly the formulae we want for the event time calculations, so column B is now ﬁlled with
calculated values of t.

A.5

Further Notes about Workshop Physics Routines

• Use the WPtools→Polynomial Fit menu command, and set Order=2 to ﬁt lines of the
form y = c0 + c1 x + c2x2 .
• If you enter non-numerical text in the cell above each column of data, it will be used
to label the horizontal and vertical axes on the plot.
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• The ﬁtting routines always use the ﬁrst selected column for the horizontal (x) points,
and the second selected column for the vertical (y) points.
• Empty rows are usually ignored (but partially-empty rows may corrupt the ﬁt).
• To delete a plot, select it (move cursor to it and click once), then press the Delete key.
To delete a column of the sheet, select the entire column (by clicking on the letter at
the top) and use Edit→Delete.
• If data are modiﬁed after running a ﬁt, the associated plot will be automatically updated, but the ﬁt parameters will not be re-calculated. Usually it is best to delete both
the old plot and ﬁt parameters after updating data.

Appendix B
Estimation of Errors
While the subject of error analysis can become quite elaborate, we ﬁrst emphasize a basic
but quite useful strategy, discussed in secs. B.1-2. Then, we distinguish between random (or
statistical uncertainties and systematic uncertainties in sec. B.3. Random uncertainties follow
the famous bell curve, as sketched in secs. B.4-5. The important distinction between the
uncertainty on a single measurement, and the uncertainty on the average of many repeated
measurements is reviewed in secs. B.7-7. The subject of propagation of errors on measured
quantities to the error on a function of those quantities is discussed in sec. B.8.

B.1

67% Conﬁdence

Whenever we make a measurement of some value v, we would also like to be able to say that
with 2/3 probability the value lies in the interval [v − σ, v + σ]. We will call σ the uncertainty
or error on the measurement. That is, if we repeated the measurement a very large number
of times, in about two thirds of those measurements the value v would be in the interval
stated.

B.2

A Simple Approach

Repeat any measurement three times, obtaining a set of values {vi }, i = 1, 2, 3. Report the
average (mean),
N
1 
vi
(for N = 3),
(B.1)
v̄ =
N i=1
as the best estimate of the true value of v, and the uncertainty σ as
σ=

vmax − vmin
.
2

(B.2)

If you take more than three measurements, you can still implement this procedure with
the aid of a histogram. Divide the range of observed values of v into 5-10 equal intervals
(called bins). Located the bin that contains each measurement, and draw a box one unit
high above that bin. Stack the boxes on top of one another if more than one measurement
falls in a bin. To estimate the error, determine the interval in v that contains the central 2/3
of the measurements, i.e., the central 2/3 of the boxes you just drew, and report the error
as 1/2 the length of this interval.
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Random and Systematic Uncertainties

The uncertainty in a measurement of a physical quantity can be due to intrinsic random
uncertainty (colloquially: error) as well as to systematic uncertainty.
Random uncertainties lead to diﬀerence in the values obtained on repetition of measurements. Systematic uncertainties cause the measurement to diﬀer from its ideal value by the
same amount for all repetitions of the measurement.
Random uncertainties can arise from vibrations of the components of a set-up driven by
random thermal ﬂuctuations, random noise in the electronics, and/or many other small but
uncontrolled eﬀects including quantum ﬂuctuations.
In principle, the eﬀect of random uncertainties can be made as small as desired by
repetition of the measurements, such that the dominant uncertainty is due to systematic
eﬀects (which can only be reduced by designing a better measurement apparatus).

B.4

The Bell Curve

In many cases when a measurement is repeated a large number of times the distribution of
values follows the bell curve, or Gaussian distribution:
2

2

e−(v−μ) /2σ
√
P (v) =
,
2πσ

(B.3)

where P (v)dv is the probability that a measurement is made in the interval [v, v + dv], μ
is true value of the variable v, and σ is the standard deviation or uncertainty in a single
measurement of v. See Figure B.1.

Figure B.1: The probability distribution measurements of a quantity with true value μ and
Gaussian uncertainty σ of a singe measurement. About 68% of the measurements would fall
in the interval between μ − σ and μ + σ, and 95% would fall in the interval μ ± 2σ.
The Table lists the conﬁdence that a single measurement from a Gaussian distribution
falls within various intervals about the mean. If the 100 students in Ph101 each make 100
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Table B.1: The probability (or conﬁdence) that a measurement of a Gaussiandistributed quantity falls in a speciﬁed interval about the mean.
Interval Conﬁdence
±σ
±2σ
±3σ
±4σ

68%
95%
99.7%
99.994%

measurements during these lab sessions, then 10,000 measurements will be taken in all. The
Table tells us that if those measurements have purely Gaussian ‘errors’, then we expect one
of those measurements to be more than 4σ from the mean.

B.5

Estimating Uncertainties When Large Numbers of
Measurements Are Made

One can make better estimates of uncertainties if the measurements are repeated a larger
number of times. If N measurements are made of some quantity resulting in values vi , i =
1, ...N then the mean is, of course,
N
1 
v̄ =
vi ,
(B.4)
N i=1
and the standard deviation of the measurements is
σ=






N
1 
(vi − v̄)2.
N − 1 i=1

(B.5)




Calculus experts will recognize that the operation (1/N) N
i=1 becomes P (v) dv in the limit
of large N. Then, using the Gaussian probability distribution (B.3) one veriﬁes that
v̄ = v =

B.6

 ∞
−∞

vP (v) dv,

and



σ = (v − v̄)
2

2



=

 ∞
−∞

(v − v̄)2 P (v) dv.

(B.6)

The Uncertainty on Mean of a Uniformly
Distributed Quantity

Not all measurable quantities follow the Gaussian distribution. A simple example is a quantity with a uniform distribution, say with values v equally probable over the interval [a, b].
It is clear that the average measurement would be (a + b)/2, but what is the uncertainty
of the measurement? If we adopt the simple prescription advocated in secs. B.2 we would
report the uncertainty as (b − a)/3 since 2/3 of the time the measurement would fall in an
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interval 2(b − a)/3 long. If instead we use the calculus prescription for σ given in eq. (B.6)
we ﬁnd that
b−a
b−a
,
(B.7)
σ= √
=
3.46
12
which result is often used by experts.

B.7

The Uncertainty in the Mean

Thus far we have considered only the uncertainty or spread in measured values of some
quantity v. A related but diﬀerent question is: what is the uncertainty on our best estimate

of v (which is just the mean value of our measurements, v̄ = (1/N) vi )?
The uncertainty on the mean v̄ is surely less that the uncertainty, σ, on each measurement
vi . Indeed, the uncertainty on the mean is given by
σ
σv̄ = √ ,
N

(B.8)

where σ is our estimate of the measurement error obtained from one of the methods sketched
previously.
Appendix C illustrates eq. (B.8) using measurements of g from past Ph101 labs.

B.8

The Uncertainty on a Function of Several
Variables (Propagation of Error)

In many cases we are interested in estimating the uncertainty on a quantity f that is a
function of measured quantities a, b, ... c. If we know the functional form f = f(a, b, ...c)
we can estimate the uncertainty σf using some calculus. As a result of our measurements
and the corresponding ‘error analysis’ we know the mean values of a, b, ... c and the error
estimates σa , σb , ... σc of these means. Our best estimate of f is surely just f(a, b, ...c) using
the mean values.
To estimate the uncertainty on f we note that the change in f due to small changes in
a, b, ... c is given by
∂f
∂f
∂f
Δa +
Δb + ... +
Δc.
(B.9)
Δf =
∂a
∂b
∂c
If we just averaged this expression we would get zero, since the ‘errors’ Δa, ... Δc are sometimes positive, sometimes negative, and average to zero. Rather, we square the expression
for Δf, and then average.

2

Δf =

∂f
∂a



2
2

Δa + ... +

∂f
∂c

2

Δc2 + ... + 2

∂f ∂f
ΔaΔc + ...
∂a ∂c

(B.10)

On average the terms with factors like ΔaΔc average to zero (under the important assumption that parameters a, b, ... c are independent). We identify the average of the squares of
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the changes relative to the mean values as the squares of the errors: Δa2 = σa2, etc. This
leads to the prescription


σf2

=

∂f
∂a



2

σa2

∂f
+ ... +
∂c

2

σc2 + ...

(B.11)

Some useful examples are
f = a ± b ± ... ± c



⇒

σf =

σa2 + σb2 + ... + σc2,

(B.12)

and
f = albm ...cn

⇒

σf
=
f



l2

σa
a

2

+ m2

σb
b

2

+ ... + n2

σc
c

2

,

(B.13)

where l, m and n are constants that may be negative.
For more detailed and rigorous analyses one can consult, for example:
• P.R. Bevington and D.K. Robinson, Data Reduction and Error Analysis for the Physical
Science, 2nd ed. (McGraw-Hill, New York, 1992).
• J.R. Taylor, An Introduction to Error Analysis: The Study of Uncertainties in Physical
Measurements, 2nd ed. (University Science Books, 1997).

Appendix C
Standard Deviation of the Mean of g
Suppose you make N repeated measurements of a quantity g, such as the acceleration due
to gravity. How well is the value of g determined by these measurements?
For example, during the 2006 sessions of Ph101 Lab 3 a total of 37 diﬀerent measurements
of g were made, as shown in the histogram Fig. C.1.

Figure C.1: Histogram of the values of g measured in the 2006 Ph101 Lab 3. The horizontal
axis is g, and the vertical axis is the number of times a value of g was reported to lie with
the range of g corresponding to the width of a vertical bar.
A histogram is a graph containing M vertical bars in which the height of a bar indicates
the number of data points whose value falls within the corresponding “bin”, i.e., within
the interval [gj − Δ/2, gj + Δ/2], where gj , j = 1, M and the centers of the M bins and
Δ is the bin width. One can make a histogram of a data set {gi } using Excel/Tools/Data
Analysis/Histogram. Enter the data {gi } in one column of an Excel spreadsheet. Click on the
Input Range: box of the Histogram window; then click and hold the left mouse button on the
ﬁrst data point, and drag the mouse to the last data point to enter the cell addresses of the
data. Click on Chart Output and then OK to create a basic histogram. If the number/spacing
of “bins” chosen by Excel is awkward, ﬁll a new column with a linear series of 5-10 steps
that begins near the lowest gi and ends near the highest; create a new histogram with the
Excel addresses of the ﬁrst and last elements of the bin list in the box Bin Range:.
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The mean value ḡ is calculated according to
N

ḡ =

i=1

gi

N

,

(C.1)

and was found to be ḡ = 939.5 cm/s2 for the data shown in Fig. C.1.
The distribution of the value of g is approximately Gaussian, and the standard deviation
of this distribution is calculated according to


σg =

N
i=1 (gi

− ḡ)2
,
N −1

(C.2)

with the result that σg = 9.1 cm/s2.
The standard deviation σg is a good estimate of the uncertainty on a single measurement
of g. However, after 37 measurements of g, the uncertainty on the mean value ḡ is much
smaller than σg .
An important result of statistical analysis is that the standard deviation (i.e., the uncertainty) of the mean of the N measurements is related to the standard deviation of the
distribution of those measurements by,
σg
σḡ = √ .
N

(C.3)

For the data shown in Fig. C.1, where N = 37, we obtain
9.1
σḡ = √ = 1.5 cm/s2 .
37

(C.4)

That is, we can report the result of all 37 measurements of g as
g = 979.5 ± 1.5 cm/s2 .

(C.5)

As a check that eq. (C.3) is valid, we can analyze the data another way. Namely, we can
ﬁrst calculate the means ḡi for the 5 diﬀerent sessions of Ph101 Lab 3. Then, we can make
a histogram of these 5 values, as shown in Fig. C.2.
The mean of the 5 means is 979.6 cm/s2 , which is essentially identical to the mean of the
37 individual measurements of g. The standard deviation of the 5 means shown in Fig. C.2
is calculated to be 1.6 cm/s2, which is essentially identical to the previous calculation (C.4)
of the standard deviation of the mean.
Concluding Remarks: If N were much larger than what we have here, the histogram
C.1 would approach the Gaussian distribution (the bell-curve) shown in Appendix B. The
peak in the histogram would be very close to the mean value ḡ of the measurements, which
represents the best estimate of g from the data. The standard√deviation σg ≈ width/2 is a
measure of the uncertainty of a single measurement,1 while σg / N is the uncertainty on the
best estimate ḡ.
1

Strictly speaking, the full width at half maximum of a Gaussian distribution is 2.35σg .
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Figure C.2: Histogram of the mean values of g measured in the 5 sessions of Ph101 Lab 3
in 2006.

Appendix D
Polynomial Fits in WPtools
D.1

Polynomial Regression

In this technical Appendix we sketch the formalism used in the polynomial regression method
for ﬁtting data. This is a generalization of the method of linear regression.
We start with a set of data (xj , yj ), j = 1, ...m, and we wish to ﬁt these data to the
nth-order polynomial
y(x) =

n


a i xi .

(D.1)

i=0

In general each measurement yj has a corresponding uncertainty σj . That is, if the measurements were repeated many times at coordinate xj the values of yj would follow a gaussian
distribution of standard deviation σj . We indicate in sec. D.2 how the program WPtools
proceeds in the absence of input data as to the σj .
Because of the uncertainties in the measurements yj we cannot expect to ﬁnd the ideal
values of the coeﬃcients ai, but only a set of best estimates we will call âi. However, we will
also obtain estimates of the uncertainties in these best-ﬁt parameters which we will label as
σâi .
The best-ﬁt polynomial is then
ŷ(x) =

n


âi xi .

(D.2)

i=0

The method to ﬁnd the âi is called least-squares ﬁtting as well as polynomial regression
because we minimize the square of the deviations. We introduce the famous chi square:




m
yj − ni=0 âixij
[yj − ŷ(xj )]2 
2
χ =
=
σj2
σj2
j=1
j=1
m


2

.

(D.3)

Fact: exp(−χ2/2) is the (un-normalized) probability distribution for observing a set of variables {yj (xj )} supposing the true relation of y to x is given by eq. (D.2).
A great insight is that exp(−χ2/2) can be thought of another way. It is also the (unnormalized) probability distribution that the polynomial coeﬃcients have values ai when
their best-ﬁt values are âi with uncertainties due to the measurements {yj }. Expressing this
in symbols,

n 
n

(ak − âk )(al − âl )
2
,
(D.4)
exp(−χ /2) = const × exp −
2
2σkl
k=0 l=0
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or equivalently

n 
n


2

χ /2 = const +

k=0 l=0

(ak − âk )(al − âl)
.
2
2σkl

(D.5)

The uncertainty on âk is σkk in this notation. In eqs. (D.4) and (D.5) we have introduced the
important concept that the uncertainties in the coeﬃcients âk are correlated. That is, the
2
quantity σkl
is a measure of the probability that the values of ak and al both have positive
2
can be negative indicating that when ak has a
ﬂuctuations at the same time. In fact, σkl
positive ﬂuctuation then al has a correlated negative one.
One way to see the merit of minimizing the χ2 is as follows. According to eq. (D.5) the
derivative of χ2 with respect to ak is
n
al − âl
∂χ2/2 
=
,
2
∂ak
σkl
l=0

(D.6)

so that all ﬁrst derivatives of χ2 vanish when all al = âl. That is, χ2 is a minimum when
the coeﬃcients take on their best-ﬁt values âi . A further beneﬁt is obtained from the second
derivatives:
1
∂ 2χ2/2
= 2.
(D.7)
∂ak ∂al
σkl
In practice we evaluate the χ2 according to eq. (D.3) based on the measured data. Taking
derivatives we ﬁnd


m
yj −
∂χ2/2 
=
∂âk
j=1

and

n

i=0

âi xij



−xkj

σj2



=

n 
m

âixij xkj
i=0 j=1

σj2

−

m

yj xkj
j=1

m
xkj xlj
∂ 2χ2/2 
=
≡ Mkl .
∂âk ∂âl j=1 σj2

σj2

,

(D.8)

(D.9)

To ﬁnd the minimum χ2 we set all derivatives (D.8) to zero, leading to
m

xij xkj
yj xij
â
=
≡ Vk .
i
2
2
i=0 j=1 σj
j=1 σj

m
n 


(D.10)

Using the matrix Mkl introduced in eq. (D.9) this can be written as
n


Mik âi = Vk .

(D.11)

i=0

We then calculate the inverse matrix M −1 and apply it to ﬁnd the desired coeﬃcients:
âk =

n

l=0

Mkl−1 Vl .

(D.12)

Comparing eqs. (D.7) and (D.9) we have
1
= Mkl .
2
σkl
The uncertainty in best-ﬁt coeﬃcient âi is then reported as
1
.
σâi = σii = √
Mii

(D.13)

(D.14)
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Procedure When the σj Are Not Known

This method can still be used even if the uncertainties σj on the measurements yj are not
known. When the functional form (D.1) correctly describes the data we claim that on
average the minimum χ2 has value m − n − 1.1 To take advantage of this remarkable result
we suppose that all uncertainties σj have a common value, σ. Then
χ2 =

m


[yj − ŷ(xj )]2
≈ m − n − 1,
σ2
j=1

so that



σj = σ =

m
j=1 [yj

(D.15)



− ni=0 âi xij ]2
.
m−n−1

(D.16)

In practice it appears that the error estimates from this procedure are more realistic if a
ﬁt is made using a polynomial with one order higher than needed for a ‘good’ ﬁt to the data.
Using eq. (D.16) as the estimate of the uncertainty σ on each of the measurements yj ,
the matrix Mkl of eq. (D.9) becomes
m

m−n−1
Mkl = m
xkj xlj .
n
 2
i
j  =1 [yj  −
i =0 âi xj  ] j=1

(D.17)

The estimate (D.14) of the uncertainty on the ﬁt coeﬃcient âi is now given by





n
i 2
 m
1
j  =1 [yj  −
i =0 âi xj  ]
σâi = √
=
m
(m − n − 1) j=1 x2i
Mii
j


(D.18)

When WPtools performs a polynomial regression it generates a plot of the data points
and the best-ﬁt curve, along with numerical values of various parameters associated with the
ﬁt. Figure D.1 gives an example of a ﬁt to a set of 8 data points of the form y = x2. The
ﬁt is to the form y = a0 + a1 x + a2 x2 . The ﬁt coeﬃcients are a0 = −0.4107, a1 = −0.3274
and a2 = 1.1964. The uncertainties (standard errors) on the ﬁt coeﬃcients are reported as
SE(a0 ) = 4.0070, SE(a1 ) = 2.0429 and SE(a2 ) = 0.2216, as calculated according to eq. (D.18).
Note that the uncertainties on coeﬃcients a1 and a1 are larger than the coeﬃcients themselves, which tells us that these coeﬃcients are indistinguishable from zero.
Also indicated on the plot are the values R2 = 0.9915 and σ = 2.8721. The latter is the
uncertainty in the data points {yj }, calculated according to eq. (D.16) with m = 8 and
n = 2. The quantity R2 is deﬁned by
m

2

R =


j=1 [ŷ(xj )
m
j=1 [y(xj )

− y]2
,
− y]2

(D.19)

where the average y = m
j=1 y(xj )/m. This is a measure of the “goodness of ﬁt”. If the ﬁt is
perfect then ŷj = yj for all j and R2 = 1. It is not obvious, but R2 ≤ 1 always. The extreme
case of R2 = 0 occurs when the ﬁt has the trivial form ŷ(x) = y for all x, which in general is
a bad ﬁt. The qualitative conclusion is that if R2 is not close to 1, the ﬁt results are to be
regarded with suspicion.
1

The whole ﬁtting procedure does not make sense unless there are more data points (m) than parameters
(n + 1) being ﬁtted.
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Figure D.1: Sample plot from WPtools Polynomial Fitting.

